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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the AC
adapter comply with the user-accessible surface temperature limits defined by the International Standard
for Safety of Information Technology Equipment (IEC 60950).
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Product description
Category

Description

Product Name

HP Pavilion HDX Entertainment Series Notebook PC

Processors

Intel® Core™ 2 Extreme processors (800-MHz front side bus [FSB], 44-W):
●

X9000 2.8-GHz, 6-MB L2 cache processor

●

X7900 2.8-GHz, 4-MB L2 cache processor

●

X7800 2.6-GHz, 4-MB L2 cache processor

Intel® Core Duo processors (800-MHz FSB, 35-W):
●

T9500 2.6-GHz, 6-MB L2 cache processor

●

T9300 2.5-GHz, 6-MB L2 cache processor

●

T8300 2.4-GHz, 3-MB L2 cache processor

●

T8100 2.1-GHz, 3-MB L2 cache processor

●

T7700 2.4-GHz, 4-MB L2 cache processor

●

T7500 2.2-GHz, 4-MB L2 cache processor

●

T7300 2.0-GHz, 4-MB L2 cache processor

●

T7250 2.0-GHz, 4-MB L2 cache processor

●

T7100 1.8-GHz, 4-MB L2 cache processor

System design supports up to 55-W requirement
Chipset

Northbridge: Intel PM965
Southbridge: ICH8m

Graphics

ATI Discrete PCI Express x 16 Graphics via MXM
nVidia Discrete x 16 Graphics via MXM

Panels

20.1-inch WSXGA UltraBrightView (1680 × 1050), approximately 300 nits typical
brightness
20.1-inch WSXGA UltraBrightView (1920 × 1200), approximately 300 nits typical
brightness

Memory

2 SODIMM slots
Customer-accessible/upgradable
PC2-5300, 667-MHz, DDR2
Dual-channel support
Supports up to 4096 MB of system memory
●

4096-MB total system memory (2048 MB × 2)

●

3072-MB total system memory (2048 MB + 1024 MB)
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Category

Hard drives

Description
●

2048-MB total system memory (1024 MB × 2)

●

1024-MB total system memory (512 MB × 2)

Supports all Serial ATA (SATA) 9.5-mm, 2.5-inch hard drives
RAID software support not required for second hard drive
Dual hard drive configurations:

Optical drives

●

640-GB, 5400-rpm (320 GB × 2)

●

500-GB, 5400-rpm (250 GB × 2)

●

320-GB, 5400-rpm (160 GB × 2)

●

280-GB, 5400-rpm (160 GB + 120 GB)

●

240-GB, 5400-rpm (120 GB + 120 MB)

12.7-mm tray load
Parallel ATA
Fixed (1 screw for removal)
Support for the following optical drives:

Camera

●

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe

●

HD-DVD Combo Drive

●

Blu-ray Combo (BD-ROM + DVD/CD Combo)

Low-light VGA camera
Tilt: +/- 15 degrees, with activity LED
640 × 480 by 30 frames per second

Diskette drive

Supports external USB drive only

Audio

HD audio: SigmaTel STAC9271D5TAyy
10-channel, simultaneous Voice over IP (VoIP) output (V.7.1), with 95-dB signal-to-noise ratio
(SNR)
Dolby home theater support
12-band parametric equalizer (disabled when external connections are made)
Dynamic processing for tunable compression/limiter function
Speakers requirements:
4 speakers (40 mm × 20 mm × 10 mm dimensions)
2 speaker enclosures on the display panel, each with a 30-cc chamber
40-mm subwoofer located in base enclosure with 110-cc chamber, mechanically isolated from
the computer with soft elastomeric grommets and foam
V. 7.1 analog out and supported ports
Supports Microsoft Premium requirements
Pavilion-branded Altec Lansing speakers
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Category

Description
2 omnidirectional microphones

Modem

No integrated modem

Ethernet

Intel 10/100/1000 Gigabit Ethernet network interface card (NIC)

Wireless

Integrated wireless local area network (WLAN) options by way of wireless module:
Intel PRO wireless 4965 a/b/g with 2 WLAN antennae built into the display assembly +
Bluetooth®
Intel PRO wireless 4965 a/b/g/n with 3 WLAN antennae built into the display assembly +
Bluetooth
Intel PRO wireless 3945 a/b/g with 2 WLAN antennae built into the display assembly +
Bluetooth

Integrated TV tuner options

Integrated NTSC/ATSC hybrid TV tuner (in Canada and the United States)
Integrated analog/DVB-T TV tuner (in the rest of the world)
PAL to F-jack and infrared emitter with cable, included with TV tuner option
TV tuner antennas for both DVB-T and ATSC/NTSC

External media card

One ExpressCard 54 slot, supports hybrid analog+ATSC and DVB-T TV tuner
Digital Media Slot: supports SD, MMC, SD I/O, MS, MSP, xD-Picture Card; with adapter,
supports mini versions of SD, MMC, and MS Duo (adapter is not included)

Ports

Video ports:
VGA (Dsub 15-pin) supporting 1920 × 1200 external resolution @ 75 Hz, hot plug/unplug,
and auto-detect for correct output to wide-aspect video (disabled when connected to the HP
xb3000 Notebook Expansion Base and HP Notebook QuickDock)
High-definition multimedia interface (HDMI) V.1.2 supporting 1080p with High-bandwidth
Digital Content Protection (HDCP) key
Audio ports:
Analog audio-out V.7.1
Audio-in (stereo microphone)
Audio-out (stereo headphone, 2 ports)
Center low-frequency effect (LFE) output
Front, rear, and side speaker outputs
Consumer infrared
TV tuner ports:
Stereo audio input
RF input using PAL jack
S-Video capture input
Infrared emitter jack
Other ports:
AC power through 180-W Multipin AC adapter plug (Smart AC adapter)
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Category

Description
Consumer infrared
eSATA
IEEE 1394a
RJ-45 (Ethernet, includes link and activity lights)
S-Video-out (including composite video support) via docking only
USB (4)

Remote control

The remote control is docked into the keyboard deck. The remote control can be ejected by
pressing the remote control eject button. The remote control can also be locked onto the
computer.
Software codes for all keys follow Microsoft® Media Center requirements.
The remote control battery is customer-accessible/upgradable.
Remote control weight:
●

Without batteries: 41.5 to 46.5 grams

●

With batteries: 45.0 to 50.0 grams

Remote control buttons:
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●

MS Start (MCE green)

●

Numeric keypad (0 - 9)

●

Clear

●

Enter

●

Channel up/down

●

Volume up/down

●

Fast forward/Reverse

●

Play/pause

●

Previous/next track

●

OK

●

Back

●

Mute

●

Guide

●

DVD player

●

TV (in the United States)/Teletext (in Europe, the Middle East, and Africa)

●

QuickPlay launch

●

Record

●

Information

●

Power

●

Music (in the United States)/R (in Europe, the Middle East, and Africa)

●

Photos (in the United States)/G (in Europe, the Middle East, and Africa)

Category

Description
●

Video (in the United States)/Y (in Europe, the Middle East, and Africa)

●

Zoom (in the United States)/B (in Europe, the Middle East, and Africa)

Docking

Expansion port 3 supports the HP xb3000 Notebook Expansion Base and HP Notebook
QuickDock (does not support power via dock)

Keyboard/pointing devices

14.39-inch full-size keyboard with separate numeric keypad
Touchpad supports 2-way scrolling
Taps enabled as default

Power requirements

9-cell 2.55-Ah, 83-Wh Li-ion battery
180-W non-PFC AC adapter with localized cable plug support (multiwire plug with ground
pin, supports 2-pin DC connector)

Security

Security cable slot
Fingerprint reader with VeriSoft software support

Operating system

Preinstalled:
Windows Vista® Ultimate (64-bit)
Windows Vista Premium (32-bit and 64-bit)

Serviceability

End-user replaceable parts:
AC adapter
Battery (system)
Hard drives (2)
Memory module
Optical drive
WLAN module
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External component identification

Top components
Display and top components

Item

Component

Description

(1)

Speakers (4)

Produce sound.

(2)

Internal microphones (2) (select models only)

Record sound.
NOTE: If there is a microphone icon next to each
microphone opening, the computer has internal
microphones.
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(3)

HP Webcam light

On: The integrated camera is in use.

(4)

HP Webcam

Records video and captures still photographs.

(5)

HP Webcam rotator

Tilts the camera vertically.

(6)

Internal display switch

Turns off the display if the display is closed while the computer
is on.

Chapter 2 External component identification

Top-left buttons and lights

Item

Component

Description

(1)

Power button*

●

When the computer is off, press the button to turn on the
computer.

●

When the computer is on, press the button to initiate
Sleep.

●

When the computer is in the Sleep state, press the button
briefly to exit Sleep.

●

When the computer is in Hibernation, press the button
briefly to exit Hibernation.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the computer.
To learn more about your power settings, select Start >
Control Panel > System and Maintenance > Power
Options.
(2)

(3)

Power light

Media button

●

On: The computer is on.

●

Blinking: The computer is in the Sleep state.

●

Off: The computer is off or in Hibernation.

●

Opens the QuickPlay program (for models with
QuickPlay preinstalled).

●

Opens the DVDPlay program (for models with DVDPlay
preinstalled).

NOTE: If the computer has been set up to require a logon
password, you may be asked to log on to Windows.
QuickPlay or DVDPlay opens after you log on. Refer to the
QuickPlay or DVDPlay software Help for more information.
(4)

DVD button

Opens the DVD playback feature of the QuickPlay program.
NOTE: If the computer has been set up to require a logon
password, you may be asked to log on to Windows.
QuickPlay opens after you log on. Refer to the QuickPlay
software Help for more information.

Top components
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Item

Component

Description

(5)

TV play button

Opens the TV module within the QuickPlay program.

(6)

Previous/rewind button

●

Plays the previous track or chapter when the button is
pressed once.

●

Rewinds media when the button is pressed
simultaneously with the fn key.

(7)

Stop button

Stops playback.

(8)

Play/pause button

Plays or pauses media.

(9)

Next/fast forward button

●

Plays the next track or chapter when the button is
pressed once.

●

Fast forwards media when the button is pressed
simultaneously with the fn key.

(10)

Theater mode button

Dims the lights on the computer.

(11)

Remote control button

Ejects the remote control.

(12)

Caps lock light

On: Caps lock is on.

*This table describes factory settings. For information about changing factory settings, refer to the user guides located in Help
and Support.

Top-right buttons, lights, and fingerprint reader

Item

Component

Function

(1)

Fingerprint reader

Allows a fingerprint logon to Windows, instead of a
password logon.

(2)

Wireless button

Turns the wireless feature on or off, but does not create a
wireless connection.
NOTE: To establish a wireless connection, a wireless
network must already be set up.

(3)

(4)
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Wireless light

Volume mute button

Chapter 2 External component identification

●

Blue: All integrated wireless devices, such as WLAN
devices and/or Bluetooth® devices, are turned on.

●

Amber: All integrated wireless devices are turned off.

Mutes and restores speaker sound.

Item

Component

Function

(5)

Volume mute light

●

Blue: Computer sound is turned on.

●

Amber: Computer sound is turned off.

(6)

Volume down light

Blinking: The volume scroll zone is being used to decrease
speaker volume.

(7)

Volume scroll zone

Adjusts speaker volume. Slide your finger to the left to
decrease volume and to the right to increase volume. You can
also tap the minus sign on the scroll zone to decrease volume,
or tap the plus sign on the scroll zone to increase volume.

(8)

Volume up light

Blinking: The volume scroll zone is being used to increase
speaker volume.

(9)

Treble or bass volume down light (select models only)

Blinking: The volume scroll zone is being used to decrease
treble or bass volume.

(10)

Treble or bass volume scroll zone (select models only)

Adjusts treble or bass volume. Slide your finger to the left to
decrease volume and to the right to increase volume. You can
also tap the minus sign on the scroll zone to decrease volume,
or tap the plus sign on the scroll zone to increase volume.

(11)

Treble or bass volume up light (select models only)

Blinking: The volume scroll zone is being used to increase
treble or bass volume.

(12)

Optical drive button

Releases the media tray.

(13)

Optical drive light

Blinking: The optical drive is being accessed.

(14)

Treble light (select models only)

On: The treble volume function is on.

(15)

Bass light (select models only)

On: The bass volume function is on.

(16)

Treble/bass button (select models only)

Alternates between treble and bass volume controls.

(17)

Num lock light

On: Num lock is on or the embedded numeric keypad is
enabled.

TouchPad

Top components
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Item

Component

Function

(1)

TouchPad light

●

Blue: TouchPad is enabled.

●

Amber: TouchPad is disabled.

(2)

TouchPad*

Moves the pointer and selects or activates items on the screen.

(3)

Left TouchPad button*

Functions like the left button on an external mouse.

(4)

TouchPad on/off button

Enables/disables the TouchPad.

(5)

TouchPad scroll zone*

Scrolls up or down.

(6)

Right TouchPad button*

Functions like the right button on an external mouse.

*This table describes factory settings. View or change pointing device preferences by selecting Start > Control Panel >
Hardware and Sound > Mouse.

Keys
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Item

Component

Description

(1)

esc key

Displays system information when pressed in combination
with the fn key.

(2)

Function keys

Execute frequently used system functions when pressed in
combination with the fn key.

(3)

Integrated numeric keypad keys

Can be used like the keys on an external numeric keypad.

(4)

fn key

Executes frequently used system functions when pressed in
combination with a function key or the fn key.

(5)

Windows logo key

Displays the Windows Start menu.

(6)

Windows applications key

Displays a shortcut menu for items beneath the pointer.

Chapter 2 External component identification

Front components

Item

Component

Function

(1)

Power light

●

On: The computer is on.

●

Blinking: The computer is in the Sleep state.

●

Off: The computer is off or in Hibernation.

●

On: A battery is charging.

●

Blinking: A battery that is the only available power
source has reached a low battery level or a critical
battery level.

●

Off: If the computer is plugged into an external power
source, the light is turned off when all batteries in the
computer are fully charged. If the computer is not
plugged into an external power source, the light stays
off until the battery reaches a low battery level.

(2)

Battery light

(3)

Drive light

Blinking: The hard drive or optical drive is being accessed.

(4)

Consumer infrared lens

Receives a signal from a remote control device, such as the
HP Remote Control.

(5)

Audio-in (microphone) jack

Connects an optional computer headset microphone, stereo
array microphone, or monaural microphone.

(6)

Audio-out (headphone) jacks (2)

Produce sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television
audio.

Rear components
Rear left-side components

Front components
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Item

Component

Description

(1)

Vent

Enables airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal for
the internal fan to cycle on and off during routine operation.

(2)

Infrared (IR) emitter jack

Connects the computer to your cable or satellite set-top box.

(3)

TV audio line-in jack

Connects a cable or satellite set-top box to the TV tuner for
high-quality audio.

(4)

S-Video-in jack

Connects a cable or satellite set-top box to the TV tuner for
high-quality video.

(5)

RF coaxial cable jack

Connects a coaxial cable or TV antenna.
NOTE: The computer is shipped with an RF coaxial cable
adapter. Depending on your computer model, the adapter
may be required for proper setup.

Rear right-side components

Item

Component

Description

(1)

Left- and right-side analog channel output jack

Connects optional audio speakers for left- and right-side
audio output.

(2)

Rear left- and right-side analog channel output jack

Connects optional audio speakers for rear left- and right-side
audio output.

(3)

Center channel and subwoofer analog channel output
jack

Connects an optional audio speaker for center channel and
subwoofer audio output.

(4)

Front left- and right-side analog channel output jack

Connects optional audio speakers for front left- and right-side
audio output.

(5)

Vent

Enables airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal for
the internal fan to cycle on and off during routine operation.

(6)
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Power connector
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Connects an AC adapter.

Right-side components

Item

Component

Function

(1)

USB ports (2)

Connect optional USB devices.

(2)

Optical drive

Reads optical discs, and, on select models, also writes to
optical discs.

(3)

Optical drive light

Blinking: The optical drive is being accessed.

(4)

Security cable slot

Attaches an optional security cable to the computer.
NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

Left-side components

Item

Component

Function

(1)

USB ports (2)

Connect optional USB devices.

(2)

RJ-45 (network) jack

Connects a network cable.

(3)

Expansion port 3

Connects the computer to an optional docking device or
expansion product.
NOTE: The computer has only one expansion port. The
term expansion port 3 describes the type of expansion port.

(4)

External monitor port

Connects an external VGA monitor or projector.

(5)

HDMI port (select models only)

Connects an optional video or audio device, such as a highdefinition television, or any compatible digital or audio
device.

(6)

eSATA port

Connects high-performance eSATA components, such as an
eSATA external hard drive.

(7)

1394 port

Connects an optional IEEE 1394 or 1394a device, such as
a camcorder.

Right-side components
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Item

Component

Function

(8)

Digital Media Slot light

On: A digital card is being accessed.

(9)

Digital Media Slot (select models only)

Supports the following optional digital card formats:

(10)

ExpressCard slot

●

Memory Stick (MS)

●

Memory Stick Pro (MSP)

●

MultiMediaCard (MMC)

●

Secure Digital Input/Output (SD I/O)

●

Secure Digital (SD) Memory Card

●

xD-Picture Card (XD)

●

xD-Picture Card (XD) Type H

●

xD-Picture Card (XD) Type M

Supports optional ExpressCard cards.

Bottom components

Item

Component

Function

(1)

Hard drive bay

Holds the hard drives.
NOTE: Depending on the computer model, the computer
may have 1 or 2 hard drives.

(2)

Vents (5)

Enable airflow to cool internal components.
NOTE: The computer fans start up automatically to cool
internal components and prevent overheating. It is normal
for the internal fans to cycle on and off during routine
operation.
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(3)

TV tuner module compartment

Contains the TV tuner slot.

(4)

Battery release latch

Releases the battery from the battery bay.

Chapter 2 External component identification

Item

Component

Function

(5)

Subwoofer

Contains the subwoofer speaker.

(6)

Battery bay

Holds the battery.

(7)

Memory module compartment

Contains the memory module slots.

(8)

Mini Card compartment (select models only)

Holds a WLAN device.
CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module authorized
for use in the computer by the governmental agency that
regulates wireless devices in your country or region. If you
replace the module and then receive a warning message,
remove the module to restore computer functionality, and
then contact technical support through Help and Support.

Bottom components
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3

Illustrated parts catalog

Serial number location
When ordering parts or requesting information, provide the computer serial number and model number
located on the bottom of the computer.
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Computer major components
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Item

Description

Spare part
number

(1)

Display assemblies (include wireless antenna transceivers and cables, camera module and cable, speakers,
and microphones and cables)
20.1-inch, WSXGA, TFT with BrightView

452299-001

20.1-inch, WUXGA, TFT

452300-001

NOTE: See Display assembly components on page 22 for more information on display assembly spare part
numbers.
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(2)

Rear cover

(3)

Keyboards (include keyboard cable)

448161-001

For use in Denmark, Finland, Norway, and Sweden

448159-DH1

For use in Europe

448159-021

For use in France

448159-051

For use in French Canada

448159-121

For use in Germany

448159-041

For use in Italy

448159-061

For use in Latin America

448159-161

For use in the Netherlands and Europe

448159-B31

For use in Saudi Arabia

448159-171

For use in South Korea

448159-AD1

For use in Switzerland

448159-111

For use in Taiwan

448159-AB1

For use in Thailand

448159-281

For use in Turkey

448159-141

For use in the United Kingdom

448159-031

For use in the United States

448159-001

(4)

Top cover (includes TouchPad board cable and TouchPad button cable, and LED boards and
cables)

448174-001

(5)

Audio/infrared board (includes cable)

452316-001

(6)

TouchPad on/off board (includes cable)

448167-001

(7)

Fingerprint reader board (includes cable)

448166-001

(8)

Rear USB board (includes cable)

452315-001

Plastics Kit

448171-001

(9a)

ExpressCard slot bezel

(9b)

WLAN module compartment cover

(9c)

Hard drive bay cover

(9d)

TV tuner module compartment cover
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Item

Description

Spare part
number

(9e)

Memory module compartment cover

(10)

Power connector LED board (includes cable)

452318-001

(11)

Audio connector board (includes cable)

452317-001

(12)

Video connector board (includes cable)

452321-001

(13)

System board (includes power connector cable, ExpressCard assembly, and replacement
thermal material)
For use in computer models with ATI graphics

448145-001

For use in computer models with either ATI or nVidia graphics

464591-001

(14)

RTC battery

452319-001

(15)

Front USB board (includes cable)

452314-001

(16)

Bluetooth module

398393-002

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is available in the Cable Kit, spare part number 448169-001.
(17)

Video board fan

448163-001

(18)

Video board heat sink (includes replacement thermal material)

448176-001

(19)

nVidia video board (includes replacement thermal material)

454311-001

(20)

Processors
Intel Core 2 Extreme processors (800-MHz FSB, 44-W):
●

X9000, 2.8-GHz processor, 6-MB L2 cache

459610–
001

●

X7900 2.8-GHz processor, 4-MB L2 cache

453908-001

●

X7800 2.6-GHz processor, 4-MB L2 cache

455738-001
and
452327-001

Intel Core 2 Duo processors (800-MHz FSB, 35-W):
●

T9500 2.6-GHZ processor, 6-MB L2 cache

459609-001

●

T9300 2.5-GHz processor, 6-MB L2 cache

459608-001

●

T8300 2.4-GHz processor, 3-MB L2 cache

459607-001

●

T8100 2.1-GHz processor, 3-MB L2 cache

459606-001

●

T7700 2.4-GHz processor, 4-MB L2 cache

448148-001

●

T7500 2.2-GHz processor, 4-MB L2 cache

448147-001

●

T7300 2.0-GHz processor, 4-MB L2 cache

448146-001

●

T7250 2.0-GHz processor, 4-MB L2 cache

456965-001

●

T7100 1.8-GHz processor, 4-MB L2 cache

448149-001

(21)

Processor heat sink (includes replacement thermal material)

448175-001

(22)

Processor fan

448162-001

Computer major components
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Item

Description

Spare part
number

(24)

Base enclosure (includes microphone and speaker extension cables and rubber feet)

448173-001

Rubber Feet Kit (includes 11 computer feet in 4 sizes, and rubber screw covers)

452320-001

(26)

WLAN modules
Intel 802.11a/b/g/n WLAN modules:
●

For use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States,
Venezuela, and Vietnam

441086-001

●

For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar,
Romania, Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa,
Spain, Sri Lanka, Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

441086-002

●

For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South Korea

441086-003

●

For use in South Korea

456576-AD1

Intel 802.11a/b/g WLAN modules:

(27)

(28)
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●

For use in Antigua & Barbuda, Argentina, Australia, the Bahamas, Barbados, Brunei, Canada,
Chile, the Dominican Republic, Guam, Guatemala, Hong Kong, India, Indonesia, Malaysia,
Mexico, New Zealand, Panama, Paraguay, Saudi Arabia, Taiwan, the United States, and
Vietnam

452063-001

●

For use in Aruba, Austria, Azerbaijan, Bahrain, Belgium, Bermuda, Brazil, Bulgaria, the
Cayman Islands, Colombia, Croatia, Cyprus, the Czech Republic, Denmark, Egypt, El
Salvador, Estonia, Finland, France, Georgia, Germany, Greece, Hungary, Iceland, Ireland,
Italy, Jordan, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the
Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Romania, Russia, Serbia and
Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden,
Switzerland, Turkey, the United Kingdom, and Uzbekistan

452063-002

●

For use in Ecuador, Haiti, Honduras, Pakistan, Peru, the People's Republic of China, Qatar,
South Korea, Uruguay, and Venezuela

452063-003

Hard drives (include hard drive bracket)
320-MB, 5400-rpm

459611-001

250-GB, 5400-rpm

454605-001

200-GB, 4200-rpm

448155-001

160-GB, 5400-rpm

448154-001

120-GB, 7200-rpm

445152-001

120-GB, 5400-rpm

448153-001

100-GB, 7200-rpm

452313-001

TV tuner modules
For use only in Europe, the Middle East, and Africa

448168-002

For use only in North America

448168-001
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Item

(30)

Description

Spare part
number

NTSC/ATSC compliant (analog/digital)

448168-003

Memory modules (PC2-5300, 667-MHz, DDR2)
2048-MB

448151-001

1024-MB

448150-001

512-MB

452312-001

(30)

9-cell, 2.55-Ah, 83-Wh battery

448158-001

(31)

Optical drives (include bezel and bracket)
DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe

448157-001

HD-DVD Combo Drive

448156-001

Blu-ray Combo Drive (BD-ROM + DVD/CD Combo)

462585-001

Cable Kit (not illustrated)

448169-001

Computer major components
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Item

Description

Spare part number

(1)

Display bezel

452307-001

(2)

Camera module (includes camera module brackets)

452304-001

Camera holder (not illustrated)

452305-001

(3)

Display Bracket Kit (includes left, top, and right brackets)

452303-001

(4)

Display panels
20.1-inch, WSXGA+, TFT, BrightView

452301-001

20.1-inch, WUXGA, TFT

452302-001

(5)

Speaker Kit (includes left and right speakers)

452310-001

(6)

Display inverter

452308-001

(7)

Display hinge/enclosure (includes display panel cable and wireless antenna
cables)

452306-001
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Item

Description

Spare part number

Display Rubber Pad Kit (not illustrated)

454595-001

Display Screw Kit (not illustrated)

452309-001

LCD logo kit (not illustrated)

464166-001

Plastics Kit

Item

Description

Spare part number

Plastics Kit

448171-001

(1)

WLAN module compartment cover (includes 1 captive screw, secured by a C-clip)

(2)

ExpressCard slot bezel

(3)

TV tuner module compartment cover (includes 1 captive screw, secured by a C-clip)

(4)

Memory module compartment cover (includes 2 captive screws, secured by C-clips)

(5)

Hard drive bay cover (includes 2 captive screws, secured by C-clips)

Plastics Kit
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Mass storage devices

Item

Description

(1)

Optical drives (include bezel and bracket)

(2)

Spare part number

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe

448157-001

HD-DVD Combo Drive

448156-001

Blu-ray Combo Drive (BD-ROM + DVD/CD Combo)

462585-001

Hard drives (include hard drive bracket)
320-MB, 5400-rpm

459611-001

250-GB, 5400-rpm

454605-001

200-GB, 4200-rpm

448155-001

160-GB, 5400-rpm

448154-001

120-GB, 7200-rpm

448152-001

120-GB, 5400-rpm

448153-001

100-GB, 7200-rpm

452313-001

Miscellaneous parts
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Description

Spare part number

180-W PFC AC adapter

448160-001

Bluetooth headset

443783-001

TV tuner antenna

460743-001
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Description

Spare part number

IR Blaster cable

463580-001

Adapter, PAL to F-Jack

463581-001

nVidia video board (includes replacement thermal material)

452322-001

Remote controls
For use in Europe, the Middle East, and Africa

448165-002

For use in North America

448165-001

Computer case

459570-001

Wired headset

371693-001 and
371693-003

Wireless laser mouse

455916-001

RTC battery

449137-001

Thermal material kit

413706-001

Power cords:
Argentina

436848-D01

Australia and New Zealand

436848-011

Belgium, Europe, Finland, France, Germany, Greece, the Netherlands, Norway, Portugal, Spain, and
Sweden

436848-021

Canada, French Canada, Latin America, Thailand, and the United States

436848-001

Denmark

436848-081

India

436848-D61

Italy

436848-061

South Korea

436848-AD1

Switzerland

436848-111

Taiwan

436848-AB1

The United Kingdom and Hong Kong

436848-031

Screw Kit

448172-001

●

Phillips PM3.0×12.0 screw

●

Phillips PM3.0×8.0 screw

●

Phillips PM3.0×4.0 screw

●

Phillips PM2.5×13.0 captive screw

●

Phillips PM2.5×12.0 captive screw

●

Phillips PM2.5×11.0 screw

●

Phillips PM2.5×8.0 captive screw

●

Phillips PM2.5×8.0 screw

●

Phillips PM2.5×5.0 screw

●

Phillips PM2.5×4.0 screw

Miscellaneous parts
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Description

Spare part number

●

Phillips PM2.5×3.0 broad-head screw

●

Black Phillips PM2.0×5.0 captive screw

●

Silver Phillips PM2.0×5.0 captive screw

●

Black Phillips PM2.0×4.0 screw

●

Silver Phillips PM2.0×4.0 screw

●

Phillips PM2.0×3.0 screw

●

Slotted SM1.5×9.0 shoulder screw

Sequential part number listing
Spare part
number

Description

371693-001

Wired headset with volume control

371693-003

Wired headset with volume control (glossy black)

398393-002

Bluetooth module
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth module
cable is available in the Cable Kit, spare part number 448169-001.
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413706-001

Thermal Material Kit

436848-001

2-wire power cord for use in the United States

436848-011

2-wire power cord for use in Australia

436848-021

2-wire power cord for use in Europe

436848-031

2-wire power cord for use in the United Kingdom

436848-061

2-wire power cord for use in Italy

436848-081

2-wire power cord for use in Denmark

436848-111

2-wire power cord for use in Switzerland

436848-AB1

2-wire power cord for use in Taiwan

436848-AD1

2-wire power cord for use in South Korea

436848-D01

2-wire power cord for use in Argentina

436848-D61

2-wire power cord for use in India

441086-001

Intel 802.11a/b/g/n WLAN module for use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados,
Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico, Panama,
Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States, Venezuela, and Vietnam

441086-002

Intel 802.11a/b/g/n WLAN module for use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia,
Cyprus, the Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the
Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and
Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey,
Ukraine, the United Kingdom, and Uzbekistan
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Spare part
number

Description

441086-003

Intel 802.11a/b/g/n WLAN module for use in Australia, New Zealand, Pakistan, the People's Republic of
China, and South Korea

443783-001

Bluetooth headset

448145-001

System board fro use in computer models with ATI graphics (includes power connector cable, ExpressCard
assembly, and replacement thermal material)

448146-001

Intel Core 2 Duo T7300 2.0-GHz processor (includes replacement thermal material)

448147-001

Intel Core 2 Duo T7500 2.2-GHz processor (includes replacement thermal material)

448148-001

Intel Core 2 Duo T7700 2.4-GHz processor (includes replacement thermal material)

448149-001

Intel Core 2 Duo T7100 1.8-GHz processor (includes replacement thermal material)

448150-001

1024-MB memory module (PC2-5300, 667-MHz, DDR2)

448151-001

2048-MB memory module (PC2-5300, 667-MHz, DDR2)

448152-001

120-GB, 7200-rpm hard drive (includes hard drive bracket)

448153-001

120-GB, 5400-rpm hard drive (includes hard drive bracket)

448154-001

160-GB, 5400-rpm hard drive (includes hard drive bracket)

448156-001

HD-DVD Combo Drive (includes bezel and bracket)

448157-001

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe (includes bezel and bracket)

448158-001

Battery, 9-cell, 2.55-Ah, 83-Wh

448159-001

Keyboard for use in the United States

448159-021

Keyboard for use in Europe

448159-031

Keyboard for use in the United Kingdom

448159-041

Keyboard for use in France

448159-051

Keyboard for use in Germany

448159-061

Keyboard for use in Italy

448159-071

Keyboard for use in Spain

448159-111

Keyboard for use in Switzerland

448159-121

Keyboard for use in French Canada

448159-141

Keyboard for use in Turkey

448159-161

Keyboard for use in Latin America

448159-171

Keyboard for use in Saudi Arabia

448159-281

Keyboard for use in Thailand

448159-AB1

Keyboard for use in Taiwan

448159-AD1

Keyboard for use in South Korea

448159-B31

Keyboard for use in the Netherlands and Europe

448159-DH1

Keyboard for use in Denmark, Finland, Norway, and Sweden

Sequential part number listing
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Spare part
number

Description

448160-001

180-W AC adapter

448161-001

Rear cover

448162-001

Processor fan

448163-001

Video board fan

448164-001

Subwoofer (includes rubber isolators)

448165-001

Remote control for use in North America

448165-002

Remote control for use in Europe, the Middle East, and Africa

448166-001

Fingerprint reader board (includes cable)

448167-001

TouchPad on/off board (includes cable)

448168-001

TV tuner module for use in North America

448168-002

TV tuner module for use in Europe, the Middle East, and Africa

448168-003

TV tuner module, NTSC/ATSC-compliant

448169-001

Cable Kit

448171-001

Plastics Kit (see Plastics Kit on page 23 for more Plastics Kit information)

448172-001

Screw Kit

448173-001

Base enclosure (includes microphone and speaker extension cables and rubber feet)

448174-001

Top cover (includes TouchPad board cable and TouchPad button cable, and LED boards and cables)

448175-001

Processor heat sink (includes replacement thermal material)

448176-001

Video board heat sink (includes replacement thermal material)

449137-001

RTC battery

455916-001

Wireless laser mouse

452063-001

Intel 802.11a/b/g WLAN module for use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados,
Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico, Panama,
Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States, Venezuela, and Vietnam

452063-002

Intel 802.11a/b/g WLAN module for use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia,
Cyprus, the Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the
Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and
Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey,
Ukraine, the United Kingdom, and Uzbekistan

452063-003

Intel 802.11a/b/g WLAN module for use in Australia, New Zealand, Pakistan, the People's Republic of China,
and South Korea

452299-001

20.1-inch, WSXGA BrightView display assembly (includes camera module and cable, microphones, speakers,
and WLAN antennae)

452300-001

20.1-inch, WUXGA BrightView display assembly (includes camera module and cable, microphones, speakers,
and WLAN antennae)

452301-001

20.1-inch, WSXGA BrightView display panel

452302-001

20.1-inch, WUXGA BrightView display panel
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Spare part
number

Description

452304-001

Camera module and camera module bracket

452305-001

Camera holder

452306-001

Display hinge/enclosure (includes display cables)

452307-001

Display bezel (includes logos)

452308-001

Display inverter

452309-001

Display Screw Kit

452310-001

Speaker Kit (includes left and right speakers)

452311-001

Hinge cover

452312-001

512-MB memory module (PC2-5300, 667-MHz, DDR2)

452313-001

100-GB, 7200-rpm hard drive (includes hard drive bracket)

452314-001

Front USB board (includes cable)

452315-001

Rear USB board (includes cable)

452316-001

Audio/infrared board (includes cable)

452317-001

Audio connector board (includes cable)

452318-001

Power connector LED board (includes cable)

452319-001

RTC battery

452320-001

Rubber Feet Kit (includes 11 computer feet in 4 sizes, and rubber screw covers)

452321-001

Video connector board (includes cable)

452322-001

nVidia video board (includes replacement thermal material)

452327-001

Intel Core 2 Extreme X7800 2.6-GHz processor (includes replacement thermal material)

454311-001

nVidia video board (includes replacement thermal material)

454595-001

Display Rubber Pad Kit

454605-001

250-GB, 5400-rpm hard drive (includes hard drive bracket)

455738-001

Intel Core 2 Extreme X7800 2.6-GHz processor (includes replacement thermal material)

456576-AD1

Intel 802.11a/b/g/n WLAN module for use in South Korea

456965-001

Intel Core Duo T7250 2.0-GHz, 4-MB L2 cache processor (includes replacement thermal material)

459570-001

Computer case

459606-001

Intel Core Duo T8100 2.1-GHz, 3-MB L2 cache processor (includes replacement thermal material)

459607-001

Intel Core Duo T8300 2.4-GHz, 3-MB L2 cache processor (includes replacement thermal material)

459608-001

Intel Core Duo T9300 2.5-GHz, 6-MB L2 cache processor (includes replacement thermal material)

459609-001

Intel Core Duo T9500 2.6-GHz, 6-MB L2 cache processor (includes replacement thermal material)

459610-001

Intel Core 2 Extreme X9000, 2.8-GHz processor, 6-MB L2 cache processor (includes replacement thermal
material)

459611-001

320-MB, 5400-rpm hard drive

Sequential part number listing
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Spare part
number

Description

460743-001

TV tuner antenna

462585-000
1

HD-DVD Drive (includes bezel and bracket)

463580-001

IR Blaster cable

463581-001

Adapter, PAL to F-Jack

464166-001

LCD logo kit (not illustrated)

464591-001

System board for use in computer models with either ATI or nVidia graphics (includes power connector cable,
ExpressCard assembly, and replacement thermal material)
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Removal and replacement
procedures

Preliminary replacement requirements
Tools required
You will need the following tools to complete the removal and replacement procedures:
●

Magnetic screwdriver

●

Phillips P0 and P1 screwdrivers

●

Flat-bladed screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during disassembly
and assembly procedures.
NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance instructions.

Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.
Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme
care; these cables tear easily.

Preliminary replacement requirements
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Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:
Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the computer
is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.
Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and be
sure that the optical drive tray is closed.
Handle drives on surfaces covered with at least one inch of shock-proof foam.
Avoid dropping drives from any height onto any surface.
After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.
If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines
Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection,
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.
A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.
An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.
CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:
Keep components in their electrostatic-safe containers until you area ready to install them.
Use nonmagnetic tools.
Before touching an electronic component, discharge static electricity by using the guidelines described in
this section.
Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.
If you remove a component, place it in an electrostatic-safe container.
The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.
CAUTION: A product can be degraded by as little as 700 V.
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Typical electrostatic voltage levels
Relative humidity
Event

10%

40%

55%

Walking across carpet

35,000 V

15,000 V

7,500 V

Walking across vinyl floor

12,000 V

5,000 V

3,000 V

Motions of bench worker

6,000 V

800 V

400 V

Removing DIPS from plastic tube

2,000 V

700 V

400 V

Removing DIPS from vinyl tray

11,500 V

4,000 V

2,000 V

Removing DIPS from Styrofoam

14,500 V

5,000 V

3,500 V

Removing bubble pack from PCB

26,500 V

20,000 V

7,000 V

Packing PCBs in foam-lined box

21,000 V

11,000 V

5,000 V

Packaging and transporting guidelines
Follow these grounding guidelines when packaging and transporting equipment:
●

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

●

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

●

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

●

Place items on a grounded surface before removing items from their containers.

●

Always be properly grounded when touching a component or assembly.

●

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam.

●

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized
equipment used for moving materials is wired to ground and that proper materials are selected to
avoid static charging. When grounding is not possible, use an ionizer to dissipate electric charges.

Workstation guidelines
Follow these grounding workstation guidelines:
●

Cover the workstation with approved static-shielding material.

●

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

●

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

●

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

●

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

●

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these
items only at static-free workstations.
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●

Avoid contact with pins, leads, or circuitry.

●

Turn off power and input signals before inserting or removing connectors or test equipment.

Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.
●

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

●

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can
be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one megohm
resistance between the operator and ground. To be effective, the conductive strips must be worn in
contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
●

Antistatic tape

●

Antistatic smocks, aprons, and sleeve protectors

●

Conductive bins and other assembly or soldering aids

●

Nonconductive foam

●

Conductive tabletop workstations with ground cords of one megohm resistance

●

Static-dissipative tables or floor mats with hard ties to the ground

●

Field service kits

●

Static awareness labels

●

Material-handling packages

●

Nonconductive plastic bags, tubes, or boxes

●

Metal tote boxes

●

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.
Material

Use

Voltage protection level

Antistatic plastic

Bags

1,500 V

Carbon-loaded plastic

Floor mats

7,500 V

Metallized laminate

Floor mats

5,000 V

Unknown user password
If the computer you are servicing has an unknown user password, follow these steps to clear the password.
NOTE: These steps also clear CMOS.
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Before disassembling the computer, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

5.

Remove the RTC battery (see RTC battery on page 74).

6.

Wait approximately 5 minutes.

7.

Replace the RTC battery and reassemble the computer.

8.

Connect AC power to the computer. Do not reinsert any batteries at this time.

9.

Turn on the computer.

All passwords and all CMOS settings have been cleared.

Component replacement procedures
This chapter provides removal and replacement procedures.
There are as many as 154 screws, in 18 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and
replacement.

Serial number
Report the computer serial number to HP when requesting information or ordering spare parts. The serial
number is located on the bottom of the computer.
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Battery
Description

Spare part number

9-cell, 2.55-Ah, 83-Wh battery

448158-001

Before disassembling the computer, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery:
1.

Turn the computer upside down on a flat surface.

2.

Slide the battery release latch (1) to release the battery.

3.

Pivot the battery (2) upward and remove it from the computer (3).

To insert the battery, insert the rear edge of the battery into the battery bay and pivot the front edge of
the battery downward until it is seated. The battery release latch automatically locks the battery into place.

Computer feet
Description

Spare part number

Rubber Feet Kit (includes 11 computer feet in 4 sizes)

452320-001

The computer feet are adhesive-backed rubber pads. The feet attach to the base enclosure in the locations
illustrated below.
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Display assembly internal components
NOTE: If it has been determined that the display bezel, camera module, display inverter, display panel,
or speakers are the components that must be replaced to complete the computer repair, the display
assembly does not have to be completely removed from the computer. Replacement of these components
can be completed by removing only the display bezel. Follow the procedures in this section to replace
the display bezel, camera module, display inverter, display panel, or speakers. For information on
replacing the entire display assembly, see Display assembly on page 60.
Before removing the display bezel, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

Remove the display bezel:
1.

Turn the computer display-side up, with the rear panel toward you.

2.

Open the computer as far as possible.

3.

Remove the two rubber screw covers from the back of the display assembly (1). All rubber screw
covers and logo labels removed in this section are included in the Display Rubber Pad Kit, spare part
number 454595-001.
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4.

Remove the two Phillips 2.5×5.0 screws (2) that secure the display bezel to the display enclosure.

5.

Position the computer with the front toward you.

6.

Remove the following screw covers and logo labels:
(1) Two rubber screw covers on the display bezel top edge corners
(2) Two rubber screw covers on the display bezel top edge
(3) Four rubber screw covers on the display bezel left and right sides
(4) Speaker logo label on the display bezel lower left edge
(5) Computer model logo label on the display bezel lower right edge
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7.

Remove the ten Phillips PM2.5×5.0 screws that secure the display bezel to the display assembly.

8.

Flex the inside edges of the left and right sides (1) and the top and bottom edges (2) of the display
bezel until the bezel disengages from the display enclosure.

9.

Remove the display bezel (3). The display bezel is available using spare part number
452307-001.

10. If it is necessary to replace the camera module, remove the two Phillips PM2.5×5.0 screws (1) that
secure the camera module to the display enclosure.
11. Release the camera module (2) from the display enclosure as far as the camera module cable allows.
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12. Disconnect the camera module cable (3) from the camera module.

13. Remove the camera module. The camera module is available using spare part number
452304-001.
14. If it is necessary to replace the display inverter, remove the display inverter (1) from the display
enclosure as far as the two display inverter cables and the backlight cable allow.
15. Disconnect the two display panel cables (2) and the backlight cable (3) from the display inverter.

16. Remove the display inverter. The display inverter is available using spare part number
452308-001.
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17. If it is necessary to replace the display panel, remove the eight Phillips PM2.5×5.0 screws that secure
the display panel to the display enclosure.

18. Tilt the top edge of the display panel (1) forward until the display panel cable connector is accessible.
19. Squeeze the tabs on the display panel cable connector (2) together and disconnect the cable (3)
from the display panel.

20. Remove the display panel. The display panel is available using spare part numbers 452301-001
(20.1-inch, WSXGA+BrightView) and 452302-001 (20.1-inch, WUXGA).
21. If it is necessary to replace the speakers, disconnect the speaker cable connectors (1) from the
speaker extension cable connectors.
22. Remove the two Phillips PM2.5×5.0 screws (2) that secure each speaker to the display enclosure.
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23. Remove the speakers (3). The speakers are available using spare part number 452310-001

Reverse this procedure to install the display bezel, camera module, display inverter, display panel, and
speakers.

Hard drive
NOTE: All hard drive spare part kits include a hard drive bracket.
Description

Spare part number

320-GB, 5400-rpm

459611-001

250-GB, 5400-rpm

454605-001

200-GB, 4200-rpm

448155-001

160-GB, 5400-rpm

448154-001

120-GB, 7200-rpm

448152-001

120-GB, 5400-rpm

448153-001

100-GB, 7200-rpm

452313-001

Before removing the hard drive, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

Remove the hard drive:
1.
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Loosen the six black Phillips PM2.0×5.0 captive screws (1) that secure the hard drive bay cover to
the computer.
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2.

Lift the rear edge of the hard drive bay cover (2), swing it forward, and remove the cover. The hard
drive bay cover is included in the Plastics Kit, spare part number 448171-001.

3.

Loosen the Phillips PM2.5×12.0 screw (1) that secures each hard drive to the computer.

4.

Disconnect the hard drives (2) from the system board by sliding the hard drives away from the hard
drive connectors.

5.

Remove the hard drives (3) from the hard drive compartments.

6.

If it is necessary to replace the hard drive bracket, remove the four Phillips PM3.0×4.0 screws (1)
that secure the hard drive bracket to the hard drive.
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7.

Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.

WLAN module
Description

Spare part number

Intel 802.11a/b/g/n WLAN modules:
●

For use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States,
Venezuela, and Vietnam

441086-001

●

For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania,
Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka,
Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

441086-002

●

For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South Korea

441086-003

●

For use in South Korea

456576-AD1

Intel 802.11a/b/g WLAN modules:
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●

For use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States,
Venezuela, and Vietnam

452063-001

●

For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania,
Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka,
Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

452063-002

●

For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South Korea

452063-003
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Before removing the WLAN module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

Remove the WLAN module:
1.

Position the computer with the front toward you.

2.

Loosen the Phillips PM2.0×5.0 screw (1) that secures the WLAN module compartment cover to the
computer.

3.

Lift the right side of the WLAN module compartment cover (2), swing the cover up and to the left,
and remove the cover. The WLAN module compartment cover is included in the Plastics Kit, spare
part number 448171-001.

4.

Disconnect the WLAN antenna cables (1) from the WLAN module.
NOTE: The main WLAN antenna cable (labeled with the number 1 or with a black band) is
connected to the WLAN module “Main” terminal. The white WLAN antenna cable (labeled with the
number 2 or with a white band) is connected to the WLAN module “Aux” terminal. Computer models
equipped with an 802.11a/b/g/n WLAN module will have an additional wireless antenna
cable (2) (labeled with the number 3 or with a yellow band). Disconnect this cable.

5.

Remove the two Phillips PM2.5×5.0 screws (3) that secure the WLAN module to the system board.
(The edge of the module opposite the slot rises away from the computer.)

Component replacement procedures

45

6.

Remove the WLAN module (4) by pulling it away from the slot at an angle.
NOTE: WLAN modules are designed with a notch (5) to prevent incorrect installation into the
WLAN module slot.

Reverse this procedure to install a WLAN module.

TV tuner module
Description

Spare part number

For use only in Europe, the Middle East, and Africa

448168-002

For use only in North America

448168-001

NTSC/ATSC compliant

448168-003

Before removing the TV tuner module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

Remove the TV tuner module:
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1.

Position the computer with the front toward you.

2.

Loosen the two black Phillips PM2.0×5.0 captive screws (1) that secure the TV tuner module
compartment cover to the computer.

Chapter 4 Removal and replacement procedures

3.

Lift the left side of the TV tuner module compartment cover (2), swing the cover up and to the right,
and remove the cover. The TV tuner module compartment cover is included in the Plastics Kit, spare
part number 448171-001.

4.

Disconnect the TV tuner cable (1) from the TV tuner module.

5.

Remove the two Phillips PM2.5×5.0 screws (2) that secure the TV tuner module to the system board.
(The edge of the module opposite the slot rises away from the computer.)

6.

Remove the TV tuner module (3) by pulling it away from the slot at an angle.
NOTE: The TV tuner module is designed with a notch (4) to prevent incorrect installation into the
TV tuner module slot.

Reverse this procedure to install the TV tuner module.

Memory module
Description

Spare part number

2048-MB (667-MHz, PC2-5300, 1-DIMM)

448151-001
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Description

Spare part number

1024-MB (667-MHz, PC2-5300, 1-DIMM)

448150-001

512-MB (667-MHz, PC2-5300, 1-DIMM)

452312-001

Before removing the memory module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

Remove the memory module:
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1.

Position the computer with the front toward you.

2.

Loosen the two black Phillips PM2.0×5.0 captive screws (1) that secure the memory module
compartment cover to the computer.

3.

Lift the rear edge of the cover (2), swing it forward, and remove the cover. The memory module
compartment cover is included in the Plastics Kit, spare part number 448171-001.

4.

Spread the retaining tabs (1) on each side of the memory module slot to release the memory module.
(The edge of the module opposite the slot rises away from the computer.)
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5.

Remove the module (2) by pulling it away from the slot at an angle.
NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
memory module slot.

Reverse this procedure to install a memory module.

Optical drive
NOTE:

All optical drive spare part kits include an optical drive bezel and bracket.

Description

Spare part number

HD-DVD Combo Drive

448156-001

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe

448157-001

Blu-ray Combo Drive (BD-ROM + DVD/CD Combo)

462585-001

Before removing the optical drive, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

Remove the optical drive:
1.

Position the computer with right side toward you.

2.

Remove the Phillips PM2.5×8.0 screw (1) that secures the optical drive to the computer.

3.

Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the tab
to the left to release the optical drive from the computer.
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4.

Remove the optical drive (3).

5.

If it is necessary to replace the optical drive bracket, position the optical drive with the optical drive
bracket toward you.

6.

Remove the two Phillips PM2.0×3.0 screws (1) that secure the optical drive bracket to the optical
drive.

7.

Remove the optical drive bracket (2).

Reverse the above procedure to reassemble and install the optical drive.

Keyboard
Description
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For use in:

Spare part number

For use in:

Spare part number

Denmark, Finland, Norway, and
Sweden

448159-DH1

South Korea

448159-AD1

Europe

448159-021

Spain

448159-071

France

448159-051

Switzerland

448159-111
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Description
For use in:

Spare part number

For use in:

Spare part number

French Canada

448159-121

Taiwan

448159-AB1

Germany

448159-041

Thailand

448159-281

The Netherlands and Europe

448159-B31

Turkey

448159-141

Italy

448159-061

The United Kingdom

448159-031

Latin America

448159-161

The United States

448159-001

Saudi Arabia

448159-171

Before removing the keyboard, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

5.

Remove the hard drives (see Hard drive on page 42).

Remove the keyboard:
1.

Position the computer with the front toward you.

2.

Remove the three Phillips PM2.5×8.0 screws (1) and the four Phillips PM2.5×5.0 screws (2) that
secure the keyboard to the computer.

3.

Turn the computer display-side up, with the front toward you.

4.

Open the computer as far as possible.

5.

Lift the front edge of the keyboard (1) until it rests at an angle.
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6.

Slide the keyboard (2) forward until the tabs on the rear edge of the keyboard disengage from the
slots in the top cover.

7.

Rotate the rear edge of the keyboard (3) forward until it rests upside down on the palm rest.

8.

Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached and
disconnect the keyboard cable (2).

9.

Remove the keyboard.

Reverse this procedure to install the keyboard.

Hinge cover
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Description

Spare part number

Hinge cover

452311-001
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Before removing the hinge cover, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

Remove the hinge cover:
1.

Position the computer with the rear panel toward you.

2.

Remove the four gray rubber screw covers (1) and (2) from the hinge cover. The screw covers come
in two different sizes and are available in the Rubber Feet Kit, spare part number 452320-001.

3.

Remove the four Phillips PM3.0×8.0 screws (3) that secure the hinge cover to the computer.

4.

Remove the hinge cover (4) by pulling it away from the computer.

Reverse this procedure to install the hinge cover.

Rear cover
Description

Spare part number

Rear cover

448161-001

Before removing the rear cover, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.
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4.

Remove the battery (see Battery on page 36).

5.

Remove the hinge cover (see Hinge cover on page 52).

Remove the rear cover:
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1.

Position the computer with the front toward you.

2.

Remove the seven Phillips PM2.5×8.0 screws (1) that secure the rear cover to the computer.

3.

Remove the Mylar screw cover (2) in the optical drive bay. This screw cover is available in the Rubber
Feet Kit, spare part number 452320-001.

4.

Remove the Phillips PM2.5×4.0 screw (3) that secures the rear cover to the computer.

5.

Remove the four Phillips PM3.0×12.0 screws (1) that secure the rear cover to the computer.

6.

Remove the four Phillips PM2.5×4.0 broad-head screws (2) that secure the rear cover to the
computer.

7.

Turn the computer right-side up, with the front toward you.

8.

Open the computer as far as possible.
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9.

Remove the rear cover.

Reverse this procedure to install the rear cover.

Top cover
Description

Spare part number

Top cover (includes TouchPad board cable and TouchPad button cable, and LED boards and cables)

448174-001

Before removing the top cover, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 42)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 50)

d.

Hinge cover (see Hinge cover on page 52)

e.

Rear cover (see Rear cover on page 53)

Remove the top cover:
1.

Turn the computer upside down, with the front toward you.

2.

Remove the two Mylar screw covers (1) in the optical drive bay. These screw covers are available
in the Rubber Feet Kit, spare part number 452320-001.
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3.

Remove the two Phillips PM2.5×4.0 screws (2) and the ten Phillips PM2.5×8.0 screws (3) that secure
the top cover to the computer.

4.

Remove the four Phillips PM2.5×5.0 screws (1) and the two Phillips PM2.5×11.0 screws (2) that
secure the top cover to the computer.

5.

Turn the computer right-side up, with the front toward you.

6.

Open the computer as far as possible.
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7.

Disconnect the following cables:
(1) Fingerprint reader board cable
(2) LED board cable
(3) TouchPad board cable
(4) TouchPad on/off board cable

8.

Remove the two Phillips PM2.5×5.0 screws (1) that secure the top cover to the computer.

9.

Lift the rear edge of the top cover (2) until the top cover disengages from the computer.

10. Remove the top cover.
Reverse this procedure to install the top cover.

Fingerprint reader board
Description

Spare part number

Fingerprint reader board (includes cable)

448166-001
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Before removing the fingerprint reader board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 42)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 50)

d.

Hinge cover (see Hinge cover on page 52)

e.

Rear cover (see Rear cover on page 53)

f.

Top cover (see Top cover on page 55)

Remove the fingerprint reader board:
1.

Turn the top cover upside down, with the front toward you.

2.

Remove the two silver Phillips PM2.0×4.0 screws (1) that secure the fingerprint reader board and
bracket to the top cover.

3.

Remove the fingerprint reader board bracket (2) and fingerprint reader board (3).

Reverse this procedure to install the fingerprint reader board.

TouchPad on/off board
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Description

Spare part number

TouchPad on/off board (includes cable)

448167-001
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Before removing the TouchPad on/off board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 42)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 50)

d.

Hinge cover (see Hinge cover on page 52)

e.

Rear cover (see Rear cover on page 53)

f.

Top cover (see Top cover on page 55)

Remove the TouchPad on/off board:
1.

Turn the top cover upside down, with the front toward you.

2.

Remove the two silver Phillips PM2.0×4.0 screws (1) that secure the TouchPad on/off board to the
top cover.

3.

Remove the TouchPad on/off board (2).

Reverse this procedure to install the TouchPad on/off board.
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Display assembly
Description

Spare part number

20.1-inch, WSXGA BrightView display assembly (includes camera module and cable, microphones,
speakers, and WLAN antennae)

452299-001

20.1-inch, WUXGA BrightView display assembly (includes camera module and cable, microphones,
speakers, and WLAN antennae)

452300-001

Before removing the display assembly, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

5.

Disconnect the WLAN module antenna cables from the WLAN module (see WLAN module
on page 44).

6.

Remove the following components:
a.

Hard drive (see Hard drive on page 42)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 50)

d.

Hinge cover (see Hinge cover on page 52)

e.

Rear cover (see Rear cover on page 53)

f.

Top cover (see Top cover on page 55)

Remove the display assembly:
1.
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Close the computer and turn it upside down, with the front toward you.
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2.

Remove the six Phillips PM3.0×8.0 screws that secure the display assembly to the computer.

3.

Turn the computer display-side up, with the front toward you.

4.

Open the computer to an upright position.

5.

Disconnect the following cable connectors:
(1) Display panel cable
(2) Camera module cable
(3) Speaker cable
(4) Microphone cable
NOTE: The speaker cables are black and red and share a single connector. The microphone cables
are gray and white and share a single connector. Be sure that these connectors are correctly
reconnected when installing the display assembly.

6.

Remove the WLAN antenna cables (5) from the opening in the system board.

CAUTION: The display assembly will be unsupported when the following screws are removed. To
prevent damage to the display assembly, support the display assembly before removing the screws.
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7.

Remove the six Phillips PM3.0×8.0 screws (1) that secure the display assembly to the computer.

8.

Remove the display assembly (2).

NOTE: If it is necessary to replace any of the display assembly internal components, see Display
assembly internal components on page 37 for display bezel removal information.
Reverse this procedure to install the display assembly.

Audio/infrared board
Description

Spare part number

Audio/infrared board

452316-001

Before removing the audio/infrared board, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 42)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 50)

d.

Hinge cover (see Hinge cover on page 52)

e.

Rear cover (see Rear cover on page 53)

f.

Top cover (see Top cover on page 55)
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Remove the audio/infrared board:
1.

Disconnect the audio/infrared board cable (1) from the system board.

2.

Remove the two Phillips PM2.5×5.0 screws (2) that secure the audio/infrared board to the computer.

3.

Remove the audio/infrared board (3) from the base enclosure.

Reverse this procedure to install the audio/infrared board.

Bluetooth module
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is available in the Cable Kit, spare part number 448169-001.
Description

Spare part number

Bluetooth module

398393-002

Before removing the Bluetooth module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 42)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 50)

d.

Hinge cover (see Hinge cover on page 52)
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e.

Rear cover (see Rear cover on page 53)

f.

Top cover (see Top cover on page 55)

Remove the Bluetooth module:
1.

Disconnect the Bluetooth module cable (1) from the system board.

2.

Remove the two silver Phillips PM2.0×4.0 screws (2) that secure the Bluetooth module to the
computer.

3.

Remove the Bluetooth module (3) from the base enclosure.

Reverse this procedure to install the Bluetooth module.

Front USB board
Description

Spare part number

Front USB board

452314-001

Before removing the front USB board, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 42)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 50)

d.

Hinge cover (see Hinge cover on page 52)
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e.

Rear cover (see Rear cover on page 53)

f.

Top cover (see Top cover on page 55)

Remove the front USB board:
1.

Disconnect the front USB board cable (1) from the system board.

2.

Remove the two Phillips PM2.5×4.0 screws (2) that secure front USB board the to the computer.

3.

Remove the front USB board (3).

Reverse this procedure to install the front USB board.

Power connector LED board
Description

Spare part number

Power connector LED board (includes cable)

452318-001

Before removing the power connector LED board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 42)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 50)

d.

Hinge cover (see Hinge cover on page 52)
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e.

Rear cover (see Rear cover on page 53)

f.

Top cover (see Top cover on page 55)

Remove the power connector LED board:
1.

Disconnect the power connector LED board (1) from the system board.

2.

Remove the power connector LED board (2).

Reverse this procedure to install the power connector LED board.

Rear USB board
Description

Spare part number

Rear USB board (includes cable)

452315-001

Before removing the rear USB board, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 42)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 50)

d.

Hinge cover (see Hinge cover on page 52)

e.

Rear cover (see Rear cover on page 53)

f.

Top cover (see Top cover on page 55)
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Remove the rear USB board:
1.

Disconnect the rear USB board cable (1) from the system board.

2.

Remove the Phillips PM2.5×4.0 screw (2) that secures rear USB board the to the computer.

3.

Remove the rear USB board (3).

Reverse this procedure to install the rear USB board.

Subwoofer
Description

Spare part number

Subwoofer (includes rubber isolators)

448164-001

Before removing the subwoofer, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 42)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 50)

d.

Hinge cover (see Hinge cover on page 52)

e.

Rear cover (see Rear cover on page 53)

f.

Top cover (see Top cover on page 55)
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Remove the subwoofer:
1.

Disconnect the subwoofer cable (1) from the system board.

2.

Remove the three Phillips PM2.5×8.0 screws (2) that secure subwoofer the to the base enclosure.

3.

Remove the subwoofer (3).
CAUTION: When installing the subwoofer, do not overtighten the screws. Overtightening the
subwoofer screws can result in damage to the subwoofer grommets (4), which can cause a decrease
in the subwoofer performance.

Reverse this procedure to install the subwoofer.

Video connector board
Description

Spare part number

Video connector board (includes cable)

452321-001

Before removing the audio connector board, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 42)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 50)

d.

Hinge cover (see Hinge cover on page 52)
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e.

Rear cover (see Rear cover on page 53)

f.

Top cover (see Top cover on page 55)

g.

Subwoofer (see Subwoofer on page 67)

Remove the video connector board:
1.

Disconnect the video connector board cable (1) from the system board.

2.

Remove the Phillips PM2.5×4.0 screw (2) that secures the video connector board to the base
enclosure.

3.

Route the video connector board cable under the processor heat sink pipe (3).

4.

Remove the video connector board (4) from the base enclosure.

Reverse this procedure to install the video connector board.

Processor fan
Description

Spare part number

Processor fan

448162-001

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left and
right sides and rear panel of the computer. The computer uses two electric fans for ventilation. The fans
are controlled by a temperature sensor and are designed to turn on automatically when high temperature
conditions exist. These conditions are affected by high external temperatures, system power consumption,
power management/battery conservation configurations, battery fast charging, and software
requirements. Exhaust air is displaced through the ventilation grills located on the computer rear panel.
Before removing the processor fan, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.
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4.

Remove the battery (see Battery on page 36).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 42)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 50)

d.

Hinge cover (see Hinge cover on page 52)

e.

Rear cover (see Rear cover on page 53)

f.

Top cover (see Top cover on page 55)

g.

Subwoofer (see Subwoofer on page 67)

Remove the processor fan:
1.

Disconnect the processor fan cable (1) from the system board.

2.

Remove the two Phillips PM2.5×8.0 screws (2) that secure the processor fan to the base enclosure.

3.

Remove the processor fan (3).

Reverse this procedure to install the processor fan.

System board
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Description

Spare part number

System board for use in computer models with ATI graphics (includes power connector cable,
ExpressCard assembly, and replacement thermal material)

448145-001

System board for use in computer models with either ATI or nVidia graphics (includes power connector
cable, ExpressCard assembly, and replacement thermal material)

464591-001
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Before removing the system board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 42)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 50)

d.

Hinge cover (see Hinge cover on page 52)

e.

Rear cover (see Rear cover on page 53)

f.

Top cover (see Top cover on page 55)

g.

Subwoofer (see Subwoofer on page 67)

h.

Processor fan (see Processor fan on page 69)

When replacing the system board, be sure that the following components are removed from the defective
system board and installed on the replacement system board:
●

Memory module (see Memory module on page 47)

●

RTC battery (see RTC battery on page 74)

●

WLAN module (see WLAN module on page 44)

Remove the system board:
1.

Remove the power connector (1) from the clip built into the base enclosure.

2.

Disconnect the rear USB board cable (2) and the power connector LED board cable (3) from the
system board.
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3.

Disconnect the following cable connectors from the system board:
(1) Speaker cable
(2) Microphone cable
(3) Audio/infrared board cable
(4) Subwoofer cable
(5) Audio connector board cable

4.

Disconnect the following cables from the system board:
(1) Bluetooth module cable
(2) Front USB board cable
(3) Processor fan cable
(4) Composite video connector board cable
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5.

Remove the two SM1.5×9.0 screws (1) on each side of the expansion port 3 connector.

6.

Remove the four Phillips PM2.5×4.0 screws (2) that secure the system board to the base enclosure.
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7.

Loosen the captive Phillips PM2.5×14.0 screw (3) that secures the video heat sink and system board
to the base enclosure.

8.

Use the optical drive connector (1) to lift the right side of the system board (2) until it rests at an
angle.

9.

Remove the system board (3) by pulling it away from the base enclosure at an angle.

Reverse this procedure to install the system board.

Audio connector board
Description

Spare part number

Audio connector board (includes cable)

452317-001

Before removing the audio connector board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.
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3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 42)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 50)

d.

Hinge cover (see Hinge cover on page 52)

e.

Rear cover (see Rear cover on page 53)

f.

Top cover (see Top cover on page 55)

g.

Subwoofer (see Subwoofer on page 67)

h.

System board (see System board on page 70)

Remove the audio connector board:
1.

Remove the two Phillips PM2.5×5.0 screws (1) that secure the audio connector board to the base
enclosure.

2.

Remove the audio connector board cable (2) from the clips built into the base enclosure.

3.

Remove the audio connector board (3) from the base enclosure.

Reverse this procedure to install the audio connector board.

RTC battery
NOTE: Removing the RTC battery and leaving it uninstalled for 5 or more minutes causes all passwords
and CMOS settings to be cleared.
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Description

Spare part number

RTC battery

452319-001
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Before removing the RTC battery, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 42)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 50)

d.

Hinge cover (see Hinge cover on page 52)

e.

Rear cover (see Rear cover on page 53)

f.

Top cover (see Top cover on page 55)

g.

Subwoofer (see Subwoofer on page 67)

h.

System board (see System board on page 70)

Remove the RTC battery:
Remove the RTC battery from the socket on the system board.

Reverse this procedure to install the RTC battery.

Processor heat sink
Description

Spare part number

Processor heat sink (includes replacement thermal material)

448175-001
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Before removing the processor heat sink, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 42)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 50)

d.

Hinge cover (see Hinge cover on page 52)

e.

Rear cover (see Rear cover on page 53)

f.

Top cover (see Top cover on page 55)

g.

Subwoofer (see Subwoofer on page 67)

h.

System board (see System board on page 70)

Remove the processor heat sink:
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1.

Turn the system board upside down, with the front toward you.

2.

Loosen the three silver Phillips PM2.0×5.0 captive screws (1) that secure the processor heat sink to
the system board.

3.

Remove the processor heat sink clip (2) by sliding it to the right.
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4.

Remove the processor heat sink (3).
NOTE: Due to the adhesive quality of the thermal material located between the processor heat sink
and system board components, it may be necessary to move the processor heat sink from side to
side to detach it.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the processor heat
sink (1) and the system board (2) each time the processor heat sink is removed. Thermal material
must be installed on all surfaces before the processor heat sink is reinstalled. Replacement thermal
material is included with all processor heat sink, system board, and processor spare part kits, and
is also available using spare part number 413706-001.

Reverse this procedure to install the processor heat sink.

Processor
NOTE:

All processor spare part kits include replacement thermal material.

Desription

Spare part number

Intel Core 2 Extreme processors (800-MHz FSB, 44-W):
X9000, 2.8-GHz processor, 6-MB L2 cache

459610–001
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Desription

Spare part number

X7900 2.8-GHz processor, 4-MB L2 cache

453908-001

X7800 2.6-GHz processor, 4-MB L2 cache

455738-001 and
452327-001

Intel Core 2 Duo processors (800-MHz FSB, 35-W):
T9500 2.6-GHz processor, 6-MB L2 cache

459609-001

T9300 2.5-Ghz processor, 6-MB L2 cache

459608-001

T8300 2.4-GHz processor, 3-MB L2 cache

459607-001

T8100 2.1-GHz processor, 3-MB L2 cache

459606-001

T7700 2.4-GHz processor, 4-MB L2 cache

448148-001

T7500 2.2-GHz processor, 4-MB L2 cache

448147-001

T7300 2.0-GHz processor, 4-MB L2 cache

448146-001

T7250 2.0-GHz processor, 4-MB L2 cache

456965-001

T7100 1.8-GHz processor, 4-MB L2 cache

448149-001

Before removing the processor, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 42)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 50)

d.

Hinge cover (see Hinge cover on page 52)

e.

Rear cover (see Rear cover on page 53)

f.

Top cover (see Top cover on page 55)

g.

Subwoofer (see Subwoofer on page 67)

h.

System board (see System board on page 70)

i.

Processor heat sink (see Processor heat sink on page 75)

Remove the processor:
1.
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Turn the processor locking screw (1) one-half turn counterclockwise until you hear a click.
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2.

Lift the processor (2) straight up and remove it.
NOTE: The gold triangle (3) on the processor must be aligned with the triangle icon (4) embossed
on the processor slot when you install the processor.

Reverse this procedure to install the processor.

Video board heat sink
Description

Spare part number

Video board heat sink (includes replacement thermal material)

448176-001

Before removing the video board heat sink, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 42)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 50)

d.

Hinge cover (see Hinge cover on page 52)

e.

Rear cover (see Rear cover on page 53)

f.

Top cover (see Top cover on page 55)

g.

Subwoofer (see Subwoofer on page 67)

h.

System board (see System board on page 70)

Component replacement procedures

79

Remove the video board heat sink:
1.

Turn the system board upside down, with the front toward you.

2.

Disconnect the video board fan cable (1) from the system board.

3.

Loosen the two Phillips PM2.5×9.0 captive screws (2) and the four silver Phillips PM2.0×5.0 captive
screws (3) that secure the video board heat sink to the system board.

4.

Remove the video board heat sink (4).
NOTE: Due to the adhesive quality of the thermal material located between the video board heat
sink and system board components, it may be necessary to move the video board heat sink from
side to side to detach it.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the video board
components (1) and the video board heat sink (2) each time the video board heat sink is removed.
Thermal material must be installed on all surfaces before the video board heat sink is reinstalled.
Replacement thermal material is included with all video board heat sink and video board spare part
kits, and is also available using spare part number 413706-001.

Reverse this procedure to install the video board heat sink.
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Video board fan
Description

Spare part number

Video board fan

448163-001

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left and
right sides and rear panel of the computer. The computer uses two electric fans for ventilation. The fans
are controlled by a temperature sensor and are designed to turn on automatically when high temperature
conditions exist. These conditions are affected by high external temperatures, system power consumption,
power management/battery conservation configurations, battery fast charging, and software
requirements. Exhaust air is displaced through the ventilation grills located on the computer rear panel.
Before removing the video board fan, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 42)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 50)

d.

Hinge cover (see Hinge cover on page 52)

e.

Rear cover (see Rear cover on page 53)

f.

Top cover (see Top cover on page 55)

g.

Subwoofer (see Subwoofer on page 67)

h.

System board (see System board on page 70)

i.

Video board heat sink (see Video board heat sink on page 79)

Remove the video board fan:
1.

Turn the video heat sink upside down.

2.

Remove the three black Phillips PM2.0×4.0 screws (1) that secure the video board fan to the video
board heat sink.

Component replacement procedures
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3.

Remove the video board fan (2).

Reverse this procedure to install the video board fan.

Video board
Description

Spare part number

nVidia video board (includes replacement thermal material)

454311-001

Before removing the video board fan, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 36).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 42)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 50)

d.

Hinge cover (see Hinge cover on page 52)

e.

Rear cover (see Rear cover on page 53)

f.

Top cover (see Top cover on page 55)

g.

Subwoofer (see Subwoofer on page 67)

h.

System board (see System board on page 70)

i.

Video board heat sink (see Video board heat sink on page 79)
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Remove the video board:
1.

Remove the two Phillips PM2.5×4.0 screws (1) that secure the video board to the system board.

2.

Lift the right side of the video board (2) until it rests at an angle.

3.

Remove the video board (3) by pulling it away from the video board slot at an angle.
NOTE: Video boards are designed with a notch (4) to prevent incorrect installation into the video
board slot.

Reverse this procedure to install the video board.

Component replacement procedures
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5

Computer Setup

Starting Computer Setup
Computer Setup is a ROM-based information and customization utility that can be used even when the
Windows operating system is not working or will not load.
NOTE: The fingerprint reader does not work when accessing Computer Setup.
The utility reports information about the computer and provides settings for startup, security, and other
preferences.
To start Computer Setup:
1.

Turn on or restart the computer.

2.

Before Windows opens and while "F10 = ROM Based Setup" is displayed in the lower-left corner
of the screen, press f10.

Using Computer Setup
Changing the language of Computer Setup
The following procedure explains how to change the language of Computer Setup. If Computer Setup is
not already running, begin at step 1. If Computer Setup is already running, begin at step 2.
1.

To start Computer Setup, turn on or restart the computer, and then press f10 while “F10 = ROM
Based Setup” is displayed in the lower-left corner of the screen.

2.

Use the arrow keys to select System Configuration > Language, and then press enter.

3.

Use the arrow keys to select a language, and then press f10.

4.

When the confirmation prompt is displayed, press f10 to save your preference.

5.

To set your preferences and exit Computer Setup, select File > Save Changes And Exit, and
then follow the instructions on the screen.

Your preferences go into effect when the computer restarts in Windows.

Navigating and selecting in Computer Setup
Because Computer Setup is not Windows-based, it does not support the TouchPad. Navigation and
selection are by keystroke.
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●

To choose a menu or a menu item, use the arrow keys.

●

To select an item, press f10.

●

To close a text box or return to the menu display, press esc.

●

To display additional navigation and selection information while Computer Setup is open,, press
f1.

Chapter 5 Computer Setup

Displaying system information
The following procedure explains how to display system information in Computer Setup. If Computer Setup
is not open, begin at step 1. If Computer Setup is open, begin at step 2.
1.

To start Computer Setup, turn on or restart the computer, and then press f10 while “F10 = ROM
Based Setup” is displayed in the lower-left corner of the screen.

2.

Access the system information by using the File menu.

3.

To exit Computer Setup without changing any settings, use the arrow keys to select File > Ignore
Changes And Exit, and then follow the instructions on the screen.

Restoring default settings in Computer Setup
The following procedure explains how to restore Computer Setup default settings. If Computer Setup is
not already running, begin at step 1. If Computer Setup is already running, begin at step 2.
1.

To start Computer Setup, turn on or restart the computer, and then press f10 while “F10 = ROM
Based Setup” is displayed in the lower-left corner of the screen.

2.

Select File > Restore Defaults, and then press enter.

3.

Follow the instructions on the screen.

Computer Setup default settings are set when you exit Computer Setup and go into effect when the
computer restarts.
NOTE: Your password, security, and language settings are not changed when you restore the factory
default settings.

Closing Computer Setup
You can close Computer Setup with or without saving changes.
●

To close Computer Setup and save your changes from the current session, use either of the following
procedures:
◦

Press f10, and then follow the instructions on the screen.
– or –

◦

If the Computer Setup menus are not visible, press esc to return to the menu display. Then use
the arrow keys to select File > Save Changes And Exit, and then press enter.
When you use the f10 procedure, you are offered an option to return to Computer Setup. When
you use the Save Changes And Exit procedure, Computer Setup closes when you press enter.

●

To close Computer Setup without saving your changes from the current session:
If the Computer Setup menus are not visible, press esc to return to the menu display. Then use the
arrow keys to select File > Ignore Changes And Exit, and then press enter.

After Computer Setup closes, the computer restarts in Windows.

Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.
NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

Computer Setup menus
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File menu
Select

To do this

System information

●

View and change the system time and date.

●

View identification information about the computer.

●

View specification information for the processor, memory, and system ROM.

Restore defaults

Replace the configuration settings in Computer Setup with factory settings.
(Password and security settings are not changed when you restore the factory
settings.)

Ignore changes and exit

Cancel any changes entered during the current session. Then exit and restart the
computer.

Save changes and exit

Save changes entered during the current session. Then exit and restart the computer.
Your changes go into effect when the computer restarts.

Security menu
Select

To do this

Setup password

Enter, change, or delete a setup password.

Power-On password

Enter, change, or delete a power-on password.

Diagnostics menu
Select

To do this

Hard Drive Self-Test options

Run a comprehensive self-test on any hard drive in the system.

Memory Check

Run a comprehensive check on system memory.

System Configuration menu
NOTE: Some of the listed System Configuration options may not be supported by your computer.
Select

To do this

Language (or press f2)

Change the Computer Setup language.

Boot options

●

Set f9, f10, and f12 delay when starting up.

●

Enable/disable CD-ROM boot.

●

Enable/disable floppy boot.

●

Enable/disable internal network adapter boot.

●

Set the Express Boot Popup delay in seconds.

●

Set the boot order.

●

Enable/disable Virtualization Technology.

●

Enable/disable button sound.

Device configurations
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Specifications

Computer specifications
Metric

U.S.

Width

47.5 cm

18.70 in

Depth

33.9 cm

13.35 in

Height

5.9 cm

2.32 in

Weight (with optical drive, hard drive,
and battery)

7.00 kg

15.44 lbs

Second hard drive adds:

0.13 kg

0.28 lbs

Camera adds:

0.009 kg

0.02 lbs

Dimensions

Input power
Operating voltage

18.5 V dc @ 3.5 A - 180 W

Operating current

3.5 A or 4.74 A

Temperature
Operating (not writing to optical disc)

0°C to 35°C

32°F to 95°F

Operating (writing to optical disc)

5°C to 35°C

41°F to 95°F

Nonoperating

-20°C to 60°C

-4°F to 140°F

Relative humidity
Operating

10% to 90%

Nonoperating

5% to 95%

Maximum altitude (unpressurized)
Operating (14.7 to 10.1 psia)

-15 m to 3,048 m

-50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia)

-15 m to 12,192 m

-50 ft to 40,000 ft

Shock
Operating

125 g, 2 ms, half-sine

Nonoperating

200 g, 2 ms, half-sine

Random vibration
Operating

0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate

Nonoperating

1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.

Computer specifications
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20.1-inch, WUXGA display specifications
Metric

U.S.

Height

27.40 cm

10.79 in

Width

43.55 cm

17.15 in

Diagonal

51.10 cm

20.11 in

Number of colors

Up to 16.8 million

Contrast ratio

200:1 (typical)

Brightness

180 nits (typical)

Dimensions

Pixel resolution
Pitch

0.172 × 0.172 mm

Format

1920 × 1200

Configuration

RGB vertical stripe

Backlight

CCFT

Character display

80 × 25

Total power consumption

6.0 W

Viewing angle

+/-65° horizontal, +/-50° vertical (typical)

20.1-inch WSXGA+ display specifications
Metric

U.S.

Height

27.40 cm

10.79 in

Width

43.55 cm

17.15 in

Diagonal

51.10 cm

20.11 in

Number of colors

Up to 16.8 million

Contrast ratio

200:1

Brightness

180 nits typical

Dimensions

Pitch resolution
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Pitch

0.172 × 0.172 mm

Format

1680 × 1050

Configuration

RGB vertical stripe

Backlight

CCFT

Character display

80 × 25
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Metric

U.S.

Total power consumption

7.0 W

Viewing angle

+/-60° horizontal, +40/-50° vertical typical

Hard drive specifications
250-GB*

200-GB*

160-GB*

120-GB*

100-GB*

Height

9.5 mm

9.5 mm

9.5 mm

9.5 mm

9.5 mm

Width

70 mm

70 mm

70 mm

70 mm

70 mm

Weight

101 g

101 g

101 g

101 g

101 g

Interface type

ATA-7

ATA-7

ATA-7

ATA-7

ATA-7

Synchronous (maximum)

100 MB/sec

100 MB/sec

100 MB/sec

100 MB/sec

100 MB/sec

Security

ATA security

ATA security

ATA security

ATA security

ATA security

Single track

3 ms

3 ms

3 ms

3 ms

3 ms

Average

13 ms

13 ms

13 ms

13 ms

13 ms

Maximum

24 ms

24 ms

24 ms

24 ms

24 ms

Logical blocks

495,665,15
5

396,532,12
4

317,249,69
9

237,937,27
4

198,281,06
2

Disc rotational speed

5400-rpm

4200-rpm

5400-rpm

7200- and
5400-rpm

5400-rpm

Dimensions

Transfer rate

Seek times (typical read, including setting)

Operating temperature

5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.
NOTE:

Certain restrictions and exclusions apply. Contact technical support for details.

DVD±RW and CD-RW Super Multi Double-Layer
Combo Drive specifications
Applicable disc

Read:

Write:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo-CD, Video
CD), Multisession CD (Photo-CD, CDEXTRA, Portfolio, CD-R, CD-RW), CD-R,
CD-RW, DVD-ROM (DVD-5, DVD-9,
DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

CD-R and CD-RW
DVD+R, DVD+RW, DVD-R, DVD-RW,
DVD-RAM

Hard drive specifications
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Center hole diameter

1.5 cm (0.59 in)

Disc diameter
Standard disc

12 cm (4.72 in)

Mini disc

8 cm (3.15 in)

Disc thickness

1.2 mm (0.047 in)

Track pitch

0.74 µm

Access time

CD

DVD

Random

< 175 ms

< 230 ms

Full stroke

< 285 ms

< 335 ms

Audio output level

Audio-out, 0.7 Vrms

Cache buffer

2 MB

Data transfer rate
24X CD-ROM

3,600 KB/sec

8X DVD

10,800 KB/sec

24X CD-R

3,600 KB/sec

16X CD-RW

2,400 KB/sec

8X DVD+R

10,800 KB/sec

4X DVD+RW

5,400 KB/sec

8X DVD-R

10,800 KB/sec

4X DVD-RW

5,400 KB/sec

2.4X DVD+R(9)

2,700 KB/sec

5X DVD-RAM

6,750 KB/sec

Transfer mode

Multiword DMA Mode

Startup time

< 15 seconds

Stop time

< 6 seconds

HD-DVD combo drive
Applicable disc

90

Read:

Write:

CD-DA,, CD-Extra, CD-ROM, CD-XA, CDI, CD-I Ready, Video CD, CD-Bridge,
PhotoCD, CD-R, CD,RW, DVD-ROM
(DVD-5, DVD-9, DVD-10, DVD-18), DVDR, DVD-RW, DVD+R, DVD+RW, DVDRAM, DVD-R DL, DVD-RAM

CD-RW

Disc diameter

12cm, 8cm

Disc thickness

1.2mm

Disc center hole diameter

15mm
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DVD+R, DVD+RW, DVD-R, DVD-RW,
DVD-RAM, DVD-R DL, DVD+R DL

Reference scanning velocity

1.2 m/s (CD)
3.49 m/s (DVD SL)
3.84 m/s (DVD DL)
6.61 m/s (HD-DVD)

Track pitch

1.6µm (CD)/0.74µm (DVD)/0.4µm (HDDVD)

Access time

Random

Full stroke

CD

< 150 MS

< 230 ms

DVD

< 160 ms

< 250 ms

HD-DVD

< 330 ms

< 515 ms

Digital Audio Extraction

12X Max

Cache buffer

2 MB (Minimum)

Data transfer rate
CD-ROM and CD-R

3600 KB/sec

DVD-ROM

10800 KB/sec

16X CD-R Write

2400KB/sec

10X CD-RW Write

1500 KB/sec

4X DVD+R Write

5400 KB/sec

4X DVD+RW Write

5400 KB/sec

4X DVD-R Write

5400 KB/sec

4X DVD-RW Write

5400 KB/sec

2.4X DVD+R DL Write

3240KB/sec

3X DVD-RAM Write

4050 KB/sec

1X HD-DVD Read

4460 KB/sec

Bus Rate

16.6 MB/s with DMA support

Startup time

< 11 sec

Stop time

< 6 sec

System DMA specifications
Hardware DMA

System function

DMA0

Not applicable

DMA1*

Not applicable

DMA2*

Not applicable

DMA3

Not applicable

DMA4

Direct memory access controller

System DMA specifications
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Hardware DMA

System function

DMA5*

Available for PC Card

DMA6

Not assigned

DMA7

Not assigned

*PC Card controller can use DMA 1, 2, or 5.

System interrupt specifications
Hardware IRQ

System function

IRQ0

System timer

IRQ1

Standard 101-/102-Key or Microsoft® Natural Keyboard

IRQ2

Cascaded

IRQ3

Intel 82801DB/DBM USB2 Enhanced Host Controller—24CD

IRQ4

COM1

IRQ5*

Conexant AC—Link Audio Intel 82801DB/DBM SMBus Controller—
24C3 Data Fax Modem with SmartCP

IRQ6

Diskette drive

IRQ7*

Parallel port

IRQ8

System CMOS/real-time clock

IRQ9*

Microsoft ACPI-compliant system

IRQ10*

Intel USB UHCI controller—24C2
Intel 82852/82855 GM/GME Graphic Controller
Realtek RTL8139 Family PCI Fast Ethernet Controller

IRQ11

Intel USB EHCI controller—24CD
Intel USB UHCI controller—24C4
Intel USB UHCI controller—24C7
Intel Pro/Wireless 2200BG
TI OHCI 1394 host controller
TI PCI1410 CardBus controller

IRQ12

Synaptics PS/2 TouchPad

IRQ13

Numeric data processor

IRQ14

Primary IDE channel

IRQ15

Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none.
NOTE: PC Cards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial port
may assert IRQ3 or IRQ4.
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System I/O address specifications
I/O address (hex)

System function (shipping configuration)

000 - 00F

DMA controller no. 1

010 - 01F

Unused

020 - 021

Interrupt controller no. 1

022 - 024

Opti chipset configuration registers

025 - 03F

Unused

02E - 02F

87334 “Super I/O” configuration for CPU

040 - 05F

Counter/timer registers

044 - 05F

Unused

060

Keyboard controller

061

Port B

062 - 063

Unused

064

Keyboard controller

065 - 06F

Unused

070 - 071

NMI enable/RTC

072 - 07F

Unused

080 - 08F

DMA page registers

090 - 091

Unused

092

Port A

093 - 09F

Unused

0A0 - 0A1

Interrupt controller no. 2

I/O Address (hex)

System function (shipping configuration)

0A2 - 0BF

Unused

0C0 - 0DF

DMA controller no. 2

0E0 - 0EF

Unused

0F0 - 0F1

Coprocessor busy clear/reset

0F2 - 0FF

Unused

100 - 16F

Unused

170 - 177

Secondary fixed disk controller

178 - 1EF

Unused

1F0 - 1F7

Primary fixed disk controller

1F8 - 200

Unused

201

JoyStick (decoded in ESS1688)

202 - 21F

Unused

System I/O address specifications
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I/O address (hex)

System function (shipping configuration)

220 - 22F

Entertainment audio

230 - 26D

Unused

26E - 26

Unused

278 - 27F

Unused

280 - 2AB

Unused

2A0 - 2A7

Unused

2A8 - 2E7

Unused

2E8 - 2EF

Reserved serial port

2F0 - 2F7

Unused

2F8 - 2FF

Infrared port

300 - 31F

Unused

320 - 36F

Unused

370 - 377

Secondary diskette drive controller

378 - 37F

Parallel port (LPT1/default)

380 - 387

Unused

388 - 38B

FM synthesizer—OPL3

38C - 3AF

Unused

3B0 - 3BB

VGA

3BC - 3BF

Reserved (parallel port/no EPP support)

3C0 - 3DF

VGA

3E0 - 3E1

PC Card controller in CPU

3E2 - 3E3

Unused

3E8 - 3EF

Internal modem

3F0 - 3F7

“A” diskette controller

3F8 - 3FF

Serial port (COM1/default)

CF8 - CFB

PCI configuration index register (PCIDIVO-1)

CFC - CFF

PCI configuration data register (PCIDIVO-1)

System memory map specifications
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Size

Memory address

System function

640 KB

00000000-0009FFFF

Base memory

128 KB

000A0000-000BFFFF

Video memory

48 KB

000C0000-000CBFFF

Video BIOS
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Size

Memory address

System function

160 KB

000C8000-000E7FFF

Unused

64 KB

000E8000-000FFFFF

System BIOS

15 MB

00100000-00FFFFFF

Extended memory

58 MB

04800000-07FFFFFF

Super extended memory

58 MB

04800000-07FFFFFF

Unused

2 MB

08000000-080FFFFF

Video memory (direct access)

4 GB

08200000-FFFEFFFF

Unused

64 KB

FFFF0000-FFFFFFFF

System BIOS

System memory map specifications
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Screw listing
This section provides specification and reference information for the screws and screw locks used in the
computer. All screws and screw locks listed in this section are available in the Screw Kit, spare part number
448172-001, and the Display Screw Kit, spare part number 452309-001.

Phillips PM2.5×5.0 screw

Color

Quantity

Length

Thread

Head diameter

Black

49

5.0 mm

2.5 mm

5.0 mm

Where used: 2 screws that secure the display bezel to the display assembly
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Where used: 10 screws that secure the display bezel to the display assembly

Where used:
(1) Two screws that secure the camera module to the display enclosure
(2) Eight screws that secure the display panel to the display enclosure

Phillips PM2.5×5.0 screw
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Where used: 4 screws that secure the speakers to the display enclosure

Where used:
(1) Two screws that secure the WLAN module to the system board
(2) One screw that secures the rear cover to the computer
(3) Two screws that secure the top cover to the computer
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Where used: 2 screws that secure the TV tuner module to the system board

Where used:
(1) Four screws that secure the keyboard to the computer
(2) Four screws that secure the top cover to the computer

Phillips PM2.5×5.0 screw
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Where used: 2 screws that secure the top cover to the computer

Where used:
(1) Two screws that secure the audio/infrared board to the base enclosure
(2) One screw that secures the rear USB board to the base enclosure
(3) Two screws that secure the front USB board to the base enclosure
(4) One screw that secures the video connector board to the base enclosure

Black Phillips PM2.0×5.0 captive screw
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Color

Quantity

Length

Thread

Head diameter

Black

11

5.0 mm

2.0 mm

4.5 mm

Where used:
(1) Six captive screws (secured by C-clips) that secure the hard drive bay cover to the computer
(2) One captive screw (secured by a C-clip) that secure the WLAN module compartment cover to the
computer
(3) Two captive screws (secured by C-clips) that secure the memory module compartment cover to the
computer
(4) Two captive screws (secured by C-clips) that secure the TV tuner module compartment cover to the
computer

Phillips PM2.5×12.0 captive screw

Color

Quantity

Length

Thread

Head diameter

Silver

2

12.0 mm

2.5 mm

5.0 mm

Phillips PM2.5×12.0 captive screw 101

Where used: 2 captive screws (secured by C-clips) that secure the hard drives to the computer

Phillips PM3.0×4.0 screw

Color

Quantity

Length

Thread

Head diameter

Silver

8

4.0 mm

3.0 mm

5.0 mm

Where used: 8 screws that secure the hard drive brackets to the two hard drives
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Phillips PM2.5×8.0 screw

Color

Quantity

Length

Thread

Head diameter

Black

26

8.0 mm

2.5 mm

5.0 mm

Where used:
(1) One screw that secures the optical drive to the computer
(2) Three screws that secure the keyboard to the computer
(3) Seven screws that secure the rear cover to the computer

Phillips PM2.5×8.0 screw 103

Where used: 10 screws that secure the top cover to the computer

Where used: 3 screws that secure the subwoofer to the base enclosure

Where used: 2 screws that secure the processor fan to the base enclosure
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Phillips PM2.0×3.0 screw

Color

Quantity

Length

Thread

Head diameter

Silver

2

3.0 mm

2.0 mm

4.5 mm

Where used: 2 screws that secure the optical drive bracket to the optical drive

Phillips PM3.0×8.0 screw

Color

Quantity

Length

Thread

Head diameter

Black

16

8.0 mm

3.0 mm

5.0 mm

Phillips PM2.0×3.0 screw 105

Where used: 4 screws that secure the hinge cover to the computer

Where used: 6 screws that secure the display assembly to the computer

Where used: 6 screws that secure the display assembly to the computer
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Phillips PM2.5×4.0 screw

Color

Quantity

Length

Thread

Head diameter

Black

8

4.0 mm

2.5 mm

5.0 mm

Where used:
(1) Four screws that secure the system board to the base enclosure
(2) Two screws that secure the audio connector board to the base enclosure

Phillips PM2.5×4.0 screw 107

Where used: 2 screws that secure the video board to the system board

Phillips PM3.0×12.0 screw

Color

Quantity

Length

Thread

Head diameter

Black

4

12.0 mm

3.0 mm

5.0 mm

Where used: 4 screws that secure the rear cover to the computer

Phillips 2.5×3.0 broad-head screw
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Color

Quantity

Length

Thread

Head diameter

Black

4

3.0 mm

2.5 mm

7.0 mm

Where used: 4 screws that secure the rear cover to the computer

Phillips PM2.5×11.0 screw

Color

Quantity

Length

Thread

Head diameter

Black

2

11.0 mm

2.5 mm

5.0 mm
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Where used: 2 screws that secure the top cover to the computer

Silver Phillips PM2.0×4.0 screw

Color

Quantity

Length

Thread

Head diameter

Silver

6

4.0 mm

2.0 mm

4.5 mm

Where used:
(1) Two screws that secure the fingerprint reader board to the top cover
(2) Two screws that secure the TouchPad on/off board to the top cover
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Where used: 2 screws that secure the Bluetooth module to the base enclosure

Slotted SM1.5×9.0 shoulder screw

Color

Quantity

Length

Thread

Head diameter

Silver

2

9.0 mm

1.5 mm

1.5 mm

Where used: 2 screws that secure the system board to the base enclosure
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Phillips PM2.5×13.0 captive screw

Color

Quantity

Length

Thread

Head diameter

Silver

1

13.0 mm

2.5 mm

5.0 mm

Where used: One captive screw (secured inside the video heat sink) that secures the system board and
video board heat sink to the base enlcosure

Silver Phillips PM2.0×5.0 captive screw
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Color

Quantity

Length

Thread

Head diameter

Silver

7

5.0 mm

2.0 mm

4.5 mm

Where used:
(1) Three captive screws (secured by C-clips) that secure the processor heat sink to the system board
(2) Four captive screws (secured by C-clips) that secure the video board heat sink to the system board

Phillips PM2.5×8.0 captive screw

Color

Quantity

Length

Thread

Head diameter

Silver

2

8.0 mm

2.5 mm

5.0 mm
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Where used: 2 captive screws (secured inside the video board heat sink) that secure the video board
heat sink to the system board

Black Phillips PM2.0×4.0 screw

Color

Quantity

Length

Thread

Head diameter

Black

3

4.0 mm

2.0 mm

4.5 mm
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8

Backup and Recovery

Recovering system information
Tools provided by the operating system and Recovery Manager software are designed to help you with
the following tasks for safeguarding your information and restoring it in case of a system failure:
●

Backing up your information regularly to protect your important system files.

●

Making a set of recovery discs (Recovery Manager software feature). Recovery discs are used to
start up (boot) your computer and restore the operating system and software programs to factory
settings in case of system failure or instability.

●

Creating system restore points (operating system feature). System restore points allow you to reverse
undesirable changes to your computer by restoring the computer to an earlier state.

●

Recovering a program or driver (Recovery Manager software feature). This feature helps you reinstall
a program or driver without performing a full system recovery.

●

Performing a full system recovery (Recovery Manager software feature). With Recovery Manager,
you can recover your full factory image if you experience system failure or instability. Recovery
Manager works from a dedicated recovery partition on the hard drive or from recovery discs you
create.Back up your information regularly to protect your important system files.

Creating recovery discs
After setting up the computer for the first time, be sure to create a set of recovery discs of the full factory
image. The recovery discs are used to start up (boot) the computer and recover the operating system and
software to factory settings in case of system instability or failure.
NOTE: Handle these discs carefully and keep them in a safe place. The software allows the creation of
only one set of recovery discs.
Note the following guidelines before creating recovery discs:
●

You will need high quality CD-R, DVD-R, DVD-R with double-layer support, DVD+R, or DVD+R with
double-layer support discs (purchased separately).
NOTE: Read-write discs, such as CD-RW, DVD ± RW, and DVD±RW double-layer discs, are not
compatible with the Recovery Manager software.

●

The computer must be connected to AC power during this process.

●

Only one set of recovery discs can be created per computer.

●

Number each disc before inserting it into the computer optical drive.

●

If necessary, you can exit the program before you have finished creating the recovery discs. The next
time you open Recovery Manager, you will be prompted to continue the disc creation process.
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To create a set of recovery discs:
1.

Select Start > All Programs > Recovery Manager > Recovery Manager.
Recovery Manager opens.

2.

Click Advanced Options.
NOTE: If you are operating the computer on battery power, you will be prompted to connect to
AC power before you can go to the next step.

3.

Click Recovery disc creation, and then click Next.

4.

Follow the on-screen instructions.

Backing up your information
When to back up
●

On a regularly scheduled basis
NOTE: Set reminders to back up your information periodically.

●

Before the computer is repaired or restored

●

Before you add or modify hardware or software

Backup suggestions
●

Create a set of recovery discs using Recovery Manager.

●

Create system restore points using the Windows System Restore feature, and periodically copy them
to disc.

●

Store personal files in the Documents folder and back up these folders periodically.

●

Back up templates stored in their associated programs.

●

Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your settings.
The screen shot can be a time saver if you have to reset your preferences.
To copy the screen and paste it into a word-processing document follow these steps:
a.

Display the screen.

b.

Copy the screen:
To copy only the active screen, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

c.

Open a word-processing document, and then select Edit > Paste.

Using system restore points
When you back up your system, you are creating a system restore point. A system restore point allows
you to save and name a snapshot of your hard drive at a specific point in time. You can then recover
back to that point if you want to reverse subsequent changes made to your system.
NOTE: Recovering to an earlier restore point does not affect data files saved or e-mails created since
the last restore point.
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You also can create additional restore points to provide increased protection for your system files and
settings.

When to create restore points
●

Before you add or extensively modify software or hardware

●

Periodically, whenever the system is performing optimally
NOTE: If you revert to a restore point and then change your mind, you can reverse the restoration.

Create a system restore point
1.

Select Start > Control Panel > System and Maintenance > System.

2.

In the left pane, click System protection.

3.

Click the System Protection tab.

4.

Under Automatic restore points, select the disk for which you want to create a restore point.

5.

Click Create.
The System Protection window opens.

6.

Follow the on-screen instructions.

Restore to a previous date and time
To revert to a restore point (created at a previous date and time), when the computer was functioning
optimally, follow these steps:
1.

Select Start > Control Panel > System and Maintenance > System.

2.

In the left pane, click System protection.

3.

Click the System Protection tab.

4.

Click the System Restore button, and then click Next.
The System Restore window opens.

5.

Follow the on-screen instructions.

Performing a recovery
Recovery Manager software allows you to repair or restore the system if you experience system failure or
instability. Recovery Manager works from recovery discs that you create or from a dedicated recovery
partition on the hard drive.
NOTE: Windows has its own built-in repair features, such as System Restore and driver roll-back
capabilities. If you have not already tried these features, try them before using Recovery Manager.
NOTE: Recovery Manager recovers only software that was preinstalled at the factory. Software not
provided with this computer must be downloaded from the manufacturer's Web site or reinstalled from
the disc provided by the manufacturer.
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Recovering from the recovery discs
To restore the system from the recovery discs:
1.

Back up all personal files.

2.

Insert the first recovery disc into the optical drive and restart the computer.

3.

Follow the on-screen instructions.

Recovering from the partition on the hard drive
You can perform a recovery from the partition on the hard drive from either the Start button or f11.
To restore the system from the partition, follow these steps:
1.

Access Recovery Manager in either of the following ways:
●

Select Start > All Programs > Recovery Manager > Recovery Manager.
– or –

●

Restart the computer and press f11 while the “Press <F11> for recovery” message is displayed
on the screen. Then select Recovery Manager.

Recovery Manager opens.
2.

Click Advanced Options.

3.

Click System recovery, and then click Next.

4.

Follow the on-screen instructions.
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9

Connector pin assignments

Audio-out (headphone)

Pin

Signal

1

Audio out, left channel

2

Audio out, right channel

3

Ground

Audio-in (microphone)

Pin

Signal

1

Audio signal in

2

Audio signal in

3

Ground

External monitor
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Pin

Signal

1

Red analog

2

Green analog

3

Blue analog

4

Not connected

5

Ground

6

Ground analog

7

Ground analog

8

Ground analog

9

+5 VDC

10

Ground

11

Monitor detect

12

DDC 2B data

13

Horizontal sync

14

Vertical sync

15

DDC 2B clock

RJ-45 (network)

Pin

Signal

1

Transmit +

2

Transmit -

3

Receive +

4

Unused

5

Unused

6

Receive -

7

Unused

8

Unused

RJ-45 (network) 121

Universal Serial Bus

Pin

Signal

1

+5 VDC

2

Data -

3

Data +

4

Ground

122 Chapter 9 Connector pin assignments

10 Power cord set requirements
The wide range input feature of the computer permits it to operate from any line voltage from 100 to 120
volts AC or from 220 to 240 volts AC.
The 3-conductor power cord set included with the computer meets the requirements for use in the country
or region where the equipment is purchased.
Power cord sets for use in other countries or regions must meet the requirements of the country or region
where the computer is used.

Requirements for all countries or regions
The requirements listed below are applicable to all countries or regions:
●

The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

●

All power cord sets must be approved by an acceptable accredited agency responsible for evaluation
in the country or region where the power cord set will be used.

●

The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage rating
of 125 or 250 V AC, as required by each country or region’s power system.

●

The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard
Sheet C13 connector for mating with the appliance inlet on the back of the computer.

Requirements for specific countries or regions
Country or region

Accredited agency

Applicable note number

Australia

EANSW

1

Austria

OVE

1

Belgium

CEBC

1

Canada

CSA

2

Denmark

DEMKO

1

Finland

FIMKO

1

France

UTE

1

Germany

VDE

1

Italy

IMQ

1

Japan

METI

3

South Korea

EK

4

The Netherlands

KEMA

1

Norway

NEMKO

1

The People's Republic of China

CCC

5
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Country or region

Accredited agency

Applicable note number

Sweden

SEMKO

1

Switzerland

SEV

1

Taiwan

BSMI

4

The United Kingdom

BSI

1

The United States

UL

2

1.

The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2.

The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3.

The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4.

The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be
used.

5.

The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be
used.
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11 Recycling
Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general household
waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Caution must be exercised when removing and handling
the backlight to avoid damaging this component and causing exposure to the mercury.
CAUTION: The procedures in this appendix can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the backlight.
Careful handling must be exercised when removing these components.
NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or see
the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.
This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this appendix are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.

Battery 125

Perform the following steps to disassemble the display assembly:
1.

Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2.

Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3.

Remove the display bezel (3).

4.

Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).
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5.

Remove all screws (1) that secure the display panel assembly to the display enclosure.

6.

Remove the display panel assembly (2) from the display enclosure.

7.

Turn the display panel assembly upside down.

8.

Remove all screws that secure the display panel frame to the display panel.

9.

Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.

10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.
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12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.
14. Turn the display panel right-side up.
15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.
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17. Remove the backlight frame from the display panel.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.
18. Remove the backlight from the backlight frame.

19. Disconnect the display cable (1) from the LCD panel.
20. Remove the screws (2) that secure the LCD panel to the display rear panel.
21. Release the LCD panel (3) from the display rear panel.
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22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Symbols/Numerics
1394 port 13
A
AC adapter, spare part
number 24, 28
adapter, PAL to F-Jack
spare part numbers 30
adapter, PAL to F-Jack, spare part
number 25
analog channel output jack 12
audio connector board
removal 73
spare part number 19, 29,
73
audio, product description 2
audio-in jack
location 11
pin assignments 120
audio-out jack
location 11
pin assignments 120
audio/infrared board
removal 62
spare part number 18, 29,
62
B
backup 117
base enclosure, spare part
number 20, 28
bass light 9
battery
removal 36
spare part number 21, 27,
36
battery (RTC), spare part
numbers 25
battery bay 15
battery light 11
battery release latch 14

Bluetooth module
removal 63
spare part number 19, 26,
63
boot options 86
boot order 86
bottom components 14
button components 7, 8
buttons
DVD 7
media 7
next/fast forward 8
optical drive 9
play/pause 8
power 7
previous/rewind 8
remote control 8
stop 8
theater mode 8
treble/bass 9
TV play 8
volume mute 8
wireless 8
C
cable
spare part numbers 30
Cable Kit, spare part number 21,
28
cables, service considerations 31
camera
location 6
product description 2
camera holder
spare part number 29
camera light 6
camera module
illustrated 22
removal 39
spare part number 22, 29,
40
camera rotator 6
caps lock light 8

changing the language in Computer
Setup 84
chipset, product description 1
closing Computer Setup 85
CMOS clearing 34
components
bottom 14
buttons 7, 8
display 6
fingerprint reader 8
front 11
keys 10
left-side 13
lights 7, 8
pointing device 9
rear 11
right-side 13
top 6
TouchPad 9
computer case
spare part numbers 25, 29
computer feet
locations 36
spare part number 20, 29,
36
Computer Setup
accessing 84
changing the language 84
closing 85
Diagnostics menu 86
File menu 86
navigating and selecting 84
restoring default settings 85
Security menu 86
System Configuration menu 86
using 84
computer specifications 87
connectors
power 12
service considerations 31
D
device configurations 86
Diagnostics menu 86
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Digital Media Slot 14
Digital Media Slot light 14
diskette drive
precautions 32
product description 2
display assembly
removal 60
spare part numbers 18, 28,
60
display bezel
illustrated 22
removal 37
spare part number 22, 29,
39
Display Bracket Kit, spare part
number 22
display components
illustrated 22
recycling 125
display hinge/enclosure
illustrated 22
spare part number 22
display hinge/enclosure, spare part
number 29
display inverter
illustrated 22
spare part number 22, 29,
40
display panel
illustrated 22
product description 1
removal 41
spare part numbers 22, 28,
41
Display Rubber Pad Kit, spare part
number 23, 29
Display Screw Kit, spare part
number 23, 29
display specifications 88
display switch 6
docking support, product
description 5
drive light 11
drives
boot order 86
preventing damage 32
DVD button 7
DVD±RW and CD-RW Combo Drive
precautions 32
removal 49
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spare part number 21, 24,
27, 49
specifications 89
E
electrostatic discharge 32
eSATA port 13
esc key 10
Ethernet, product description 3
expansion port 3 port 13
ExpressCard slot 14
ExpressCard slot bezel 23
external media cards, product
description 3
external monitor port
location 13
pin assignments 120
F
fan

removal 69, 81
spare part numbers 19, 28,
69, 81
feet
locations 36
spare part number 20, 29,
36
File menu 86
fingerprint reader 8
fingerprint reader board
removal 57
spare part number 18, 28,
57
fn key 10
front components 11
front USB board
removal 64
spare part number 19, 29,
64
function keys 10
G
graphics, product description
grounding equipment and
methods 34
H
hard drive
precautions 32
product description
removal 42

2

1

spare part numbers 20, 24,
27, 29, 42
specifications 89
hard drive bay 14
hard drive bay cover
illustrated 23
removal 43
hard drive test 86
HD-DVD Combo Drive
specifications 90
HD-DVD Drive
precautions 32
removal 49
spare part number 21, 24,
27, 30, 49
HDMI port, location 13
headphone jack
location 11
pin assignments 120
headset, spare part numbers 24,
25, 26, 27
heat sink
removal 75, 79
spare part numbers 19, 28,
75, 79
hinge cover
removal 52
spare part number 29, 52
HP Webcam light 6
HP Webcam rotator 6
HP Webcom 6
I
I/O address specifications 93
infrared lens 11
interrupt specifications 92
inverter
illustrated 22
spare part number 22, 29
IR Blaster cable, spare part
number 25
IR emitter jack 12
J
jacks
analog channel output
analog channel output
jack 12
audio-in 11
audio-out 11

12

headphone 11
IR emitter 12
microphone 11
network 13
RF coaxial cable jack 12
RJ-45 13
S-Video-in 12
subwoofer analog channel
output 12
TV audio line-in 12
K
key components 10
keyboard
product description 5
removal 50
spare part numbers 18, 27,
50
keypad keys 10
keys
esc 10
fn 10
function 10
keypad 10
Windows application 10
Windows logo 10
L
language, changing in Computer
Setup 86
LCD logo kit
spare part numbers 30
LCD logo kit, spare part
number 23
left-side components 13
light components 7, 8
lights
bass 9
battery 11
caps lock 8
drive 11
num lock 9
optical drive 9
power 7, 11
treble 9
treble or bass volume down 9
treble or bass volume up 9
volume 9
volume down 9

volume mute 9
wireless 8
M
mass storage devices, spare part
numbers 24
media button 7
memory check 86
memory map specifications 94
memory module
product description 1
removal 47
spare part numbers 27, 29,
47
memory module compartment 15
memory module compartment cover
illustrated 23
removal 48
microphone 6
microphone jack
location 11
pin assignments 120
Mini Card compartment 15
model name 1
modem, product description 3
monitor port
location 13
pin assignments 120
mouse
spare part number 28
mouse, spare part number 25
N
navigating in Computer Setup 84
network jack
location 13
pin assignments 121
next/fast forward button 8
num lock light 9
O
operating system, product
description 5
optical drive
location 13
precautions 32
product description 2
removal 49
spare part numbers 21, 24,
49
specifications 89, 90

optical drive button 9
optical drive light 9, 13
P
packing guidelines 33
password clearing 34
passwords 86
pin assignments
audio-in 120
audio-out 120
external monitor 120
headphone 120
microphone 120
monitor 120
network 121
RJ-45 121
Universal Serial Bus (USB) 122
plastic parts 31
Plastics Kit
contents 23
spare part number 18, 23,
28
play/pause button 8
pointing device
components 9
product description 5
ports
1394 13
eSATA 13
expansion port 3 13
external monitor port 13
HDMI 13
monitor port 13
product description 3
Universal Serial Bus
(USB) 13
power button 7
power connector 12
power connector LED board
removal 65
spare part number 19, 29,
65
power cord set requirements 123
power cord, spare part
numbers 25, 26
power light 7, 11
power requirements, product
description 5
power-on password 86
previous/rewind button 8
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processor
product description 1
removal 77
spare part numbers 19, 27,
29, 77
processor fan
removal 69
spare part number 19, 28,
69
processor heat sink
removal 75
spare part number 19, 28,
75
product description
audio 2
camera 2
chipset 1
diskette drive 2
display panel 1
docking support 5
Ethernet 3
external media cards 3
graphics 1
hard drives 2
keyboard 5
memory module 1
modem 3
operating system 5
optical drives 2
pointing device 5
ports 3
power requirements 5
processors 1
product name 1
remote control 4
security 5
serviceability 5
TV tuner 3
wireless 3
product name 1
R
rear components 11
rear cover
removal 53
spare part number 18, 28,
53
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rear USB board
removal 66
spare part number 18, 29,
66
recovery discs 116
recovery, system 116, 118
remote control
product description 4
spare part numbers 25, 28
remote control button 8
removal/replacement
preliminaries 31
procedures 35
restore points 117
restoring Computer Setup default
settings 85
RF coaxial cable jack jack 12
right-side components 13
RJ-45 jack
location 13
pin assignments 121
RTC battery
removal 74
spare part number 19, 28,
29, 74
RTC battery, spare part
numbers 25
Rubber Feet Kit, spare part
number 20, 29, 36
S
S-Video-in jack 12
Screw Kit
contents 96
spare part number 25, 28
screw listing 96
security cable slot 13
Security menu 86
security, product description 5
selecting in Computer Setup 84
serial number 16, 35
service considerations 31
serviceability, product
description 5
software
safeguarding information 116
Speaker Kit, spare part
number 22, 29
speakers
illustrated 22

location 6
spare part number 22, 29,
42
specifications
computer 87
display 88
DVD±RW and CD-RW Combo
Drive 89
hard drive 89
HD-DVD Combo Drive 90
I/O addresses 93
interrupts 92
memory map 94
optical drive 89, 90
system DMA 91
static-shielding materials 34
stop button 8
subwoofer
location 15
removal 67
spare part number 28, 67
subwoofer analog channel output
jack 12
system board
removal 70
spare part number 19, 27,
30, 70
System Configuration menu 86
system DMA 91
system information 86
system memory map 94
system recovery 116
system restore points 117
T
theater mode button 8
Thermal Material Kit, spare part
number 26
thermal material kit, spare part
number 25
thermal material,
replacement 77, 80
tools required 31
top components 6
top cover
removal 55
spare part number 18, 28,
55
TouchPad components
left button 10

light 10
on/off button 10
right button 10
scroll zone 10
TouchPad 10
TouchPad on/off board
removal 58
spare part number 18, 28,
58
transporting guidelines 33
treble light 9
treble or bass volume down
light 9
treble or bass volume scroll
zone 9
treble or bass volume up light 9
treble/bass button 9
TV audio line-in jack 12
TV play button 8
TV tuner
product description 3
TV tuner antenna
spare part numbers 30
TV tuner antenna, spare part
number 24
TV tuner module
removal 46
spare part numbers 20, 28,
46
TV tuner module compartment 14
TV tuner module compartment cover
illustrated 23
removal 47
U
Universal Serial Bus (USB) port
locations 13
pin assignments 122
unknown password 34
USB board
removal 66
spare part numbers 18, 19,
29, 64, 66
V
vents 12, 14
video board
removal 82
spare part number
82

video board fan
removal 81
spare part number 19, 28,
81
video board heat sink
removal 79
spare part number 19, 28,
79
video board, spare part
numbers 25
video connector board
removal 68
spare part number 19, 29,
68
volume down light 9
volume mute button 8
volume mute light 9
volume scroll zone 9
volume up light 9
W
Windows application key 10
Windows logo key 10
wireless button 8
wireless light 8
wireless, product description 3
WLAN module
removal 44
spare part numbers 20, 26,
28, 29, 44
WLAN module compartment cover
illustrated 23
removal 45
workstation guidelines 33

19, 29,
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